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1 Introduction to MarkVision Professional

Introduction

MarkVisionTM Professional (MVP) is a Web-enabled device management utility designed for IT staff. 

MarkVision works as a client-server application. The server component is responsible for discovering 
and communicating with devices on the network and providing information about them to a client. 
The client is then responsible for displaying information about the devices to a user and providing 
them with an interface to manage those devices. 

The ability to use MarkVision through a web client provides the convenience of accessing all of 
MVP's management options from virtually any location. While MarkVision's built-in security 
provisions prevent unauthorized access to devices on your network, an authorized user can access 
an instance of the web client by connecting to the MarkVision Server through supported web 
browsers. After logging on, all of the information being managed by MarkVision becomes instantly 
available to authorized users anywhere with web access. 

MarkVision's highly customizable format and various tasks also provide you with highly versatile 
options for managing your devices. You can configure MarkVision to display specific device 
information, so you see only the information of interest to you. By using Quick Find or by creating 
Discovery Profiles, you can quickly and efficiently locate specific devices on your network. Extensive 
Folders and Filters can then be used to group devices based on one or multiple characteristics (such 
as color capability, input capacity, and speed) or conditions (such as cover open, low toner, low 
paper, and paper jam). 

The goal of MarkVision Professional is to provide the most comprehensive and efficient device 
management capabilities available. Here are a few brief examples of what MarkVision can do:

MarkVision helps to: 

• Quickly troubleshoot printing issues on the network and fix them before they become critical 
and disruptive. 

• Remotely perform printer and print server maintenance and routine updates. 

With MarkVision Professional, you can: 

• Diagnose and fix printing problems using Quick Find to locate a specific device on the 
network. 

• Use extensive Filters to find and group devices based on one or more characteristics (such 
as color capability, input capacity, and speed) or conditions (such as cover open, low toner, 
low paper, and paper jam). 

• Configure settings on multiple devices simultaneously. 
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• Display devices that meet predefined criteria (such as Toner Low) so you can fix problems 
before they affect user productivity. 

• Schedule time-intensive activities, such as company-wide device discovery, gathering printer 
inventory data, or updating print server firmware when network use is at a minimum. 

• Prevent unauthorized access to devices on the network. 
• Download plug-ins for additional device support at runtime. 

Note: This book is written for administrators. To complete these tasks successfully, you 
should have a working knowledge of your network hardware and software. 

MarkVision components

The MarkVision client

The MarkVision client is a Java program that provides the user with an interface for managing 
devices. The client can exist in two forms: as a stand-alone Java application or as a browser-based 
Java applet. 

MarkVision Client Application

The stand-alone application can be installed locally on a user’s workstation. MarkVision client files 
are then copied onto the user’s computer during the installation process. 

MarkVision Web Client

The browser-based client is a version of the client that can be accessed through a supported web 
browser by using the URL http://<yourserver>/markvision. If the MarkVision Server is not the 
default server on your machine, you can use the URL http://<yourserver>:9180/markvision. 

In order to run the web client, you must first enable your web browser to support Sun’s Java Runtime 
Environment (JRE) by installing the Java plug-in. 

Note: In Windows environments, the plug-in is provided and the user will automatically be 
prompted to install it the first time they run the MarkVision web client. For 
information on the Java plug-in software and to download available versions of the 
plug-in for UNIX and other platforms, go to: http://java.sun.com/products/plugin/
index.html

The MarkVision client application and the web client are essentially the same program. All 
information that is being managed by the MarkVision Server is available to users of either the 
application or web client. The only differences are that the application does not require installation of 
the Java plug-in and may require less startup time because some files are stored locally on the user’s 
workstation. However, anyone who does not run MarkVision Professional on a regular basis, or who 
is not currently working from their workstation, should use the web client version of MVP. In this case, 
there is no need to install any MarkVision files in order to use the client. 

http://java.sun.com/products/plugin/index.html
http://java.sun.com/products/plugin/index.html
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MarkVision Messenger

MarkVision Messenger works with MarkVision Professional to provide technicians with e-mail 
notification or command line execution when a network printer triggers a pre-defined event (such as 
Paper Tray Missing, Toner Low, and many more). The heart of MarkVision Messenger is a “service” 
that runs inside the MarkVision Server. To use this service, the user creates “actions” using a 
browser-based interface. Users can access MarkVision Messenger either by launching it from the 
Action menu in the MVP application, or by using the URL http://<yourserver>/messenger in your 
browser. For more information see the MarkVision Messenger section of this User’s Guide.

MarkVision Server

The MarkVision Server is the engine that powers MarkVision. The MarkVision Server is the single 
point of contact between an instance of the MarkVision client and all of the devices that MVP 
manages. Every time a client requests information, the MarkVision Server gathers new information 
from the device and stores it in a cache. This saves valuable network resources both on the network 
as well as the individual print servers by eliminating redundant network traffic from duplicate 
requests. 

The MarkVision Server also eliminates the complexity of talking to a wide variety of network devices. 
Client programs only need to send a single protocol to the server, which in turn knows how to 
communicate with the devices.

In order for the system architecture to work, at least one MarkVision Server must exist on a network. 
It is possible to install multiple instances of the MarkVision Server on a network, however, a client 
can only connect with one server at a time.

MarkVision Web Server

MarkVision Professional provides a web server for the browser-based components of the product 
(MVP web client and MarkVision Messenger) as part of the MarkVision Professional package. The 
MVP web server is automatically installed along with the MarkVision Server. 

During installation, you are given the option to make the MarkVision web server the default server on 
the machine. This allows the browser-based application to access the server from the standard port 
(80), which requires no additional numbering in the URL. If this option is not selected, the MVP web 
server accepts HTTP requests on a non-standard port (9180) that does not interfere with any other 
existing web servers. 

Terms used in this document

MarkVision Professional (also referred to as MarkVision or MVP) refers to the components that make 
up MarkVision Professional: the MarkVision Server, the MarkVision Web Client, and the Web site 
files that enable remote installation of MarkVision Professional. 

MarkVision Web Client refers to MarkVision Professional running through a browser. 
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MarkVision Server refers to a server that collects data from network-attached printers and provides 
information to MarkVision clients. 

Note: Within this document, printers and print servers are in some instances referred to 
as "devices." 

System requirements

The following are minimum requirements for installing and running MarkVision Professional on your 
network. These requirements are for both the server and the client, and should be in place before 
you install MarkVision.

Client system:

• Windows 95/98/Me, Windows NT, Windows 2000, Windows XP, Windows 2003 Server, or 
Mac OS X, or a supported UNIX client system 

• 30MB available hard disk space 

• Dial-up or 10Mbps (or greater) TCP/IP connection 

• A supported web browser, such as Windows Internet Explorer 4.x, 5.x, 6.x, or later, or 
Netscape Navigator 6.x or later 

• Java 1.4 software update (see table for specific operating systems)

Server system:

• Windows NT (Service Pack 4.0 or later), Windows 2000, Windows XP, Windows 2003 Server, 
Mac OS X server 10.2.3, or a supported UNIX server system 

• 70MB available hard disk space 

• Dial-up or 10Mbps (or greater) TCP/IP connection 

• Java 1.4 software update (see table for specific operating systems)

Minimum RAM and processor configurations for multiple devices

Note: Managing more than 2500 printers requires additional servers. 

Number of printers
Total RAM on 
computer (MB)

Processor speed 
of computer (MHz)

1–250 128 350

250–500 192 500

500–1000 256 500

1000–2500 512 500
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MarkVision Professional for UNIX systems

MarkVision Professional for UNIX systems is available for all supported UNIX platforms that provide 
Java Runtime Environment 1.4 (Java 1.1.x and 1.2.2 are not supported). 

Supported UNIX systems 

Java Virtual Machine recommendations

Supported devices

Operating system Version numbers Hardware

IBM-AIX 4.3.3, 5.1, 5.2 IBM RISC System/6000

HP-UX 11.0 Hewlett-Packard 9000/700 and 
9000/800

Red Hat Linux 7.1, 7.2, 7.3, 8.0 Intel (IA32)

SuSE Linux 7.1, 7.2, 7.3, 8.0 Intel (IA32)

Sun Solaris SPARC 2.6, 7, 8, 9 Sun SPARC and Ultra SPARC

Operating system Java VM level

Windows Sun 1.4.0_03

IBM-AIX 4.3.3 IBM 1.3.1—MarkVision Server

IBM-AIX 5.1, 5.2 IBM 1.4—MarkVision Client

Mac OS X 10.x Apple 1.41

HP-UX HP 1.4.1_02

Red Hat Linux Sun 1.4.1_01

SuSE Linux Sun 1.4.1_01

Sun Solaris SPARC Sun 1.4.1_01

Lexmark printers

IBM LaserPrinter 4039 Lexmark™ Optra™ M

Lexmark 4079 plus Lexmark Optra N

Lexmark C750 Lexmark Optra Plus

Lexmark C910 Lexmark Optra S

Lexmark C912 Lexmark Optra SC

Lexmark E320 Lexmark Optra Se
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Lexmark E321 Lexmark Optra Se plus

Lexmark E322 Lexmark Optra T

Lexmark E323 Lexmark Optra W810

Lexmark Optra Lexmark T420

Lexmark Optra C Lexmark T520

Lexmark Optra C710 Lexmark T520 SBE

Lexmark Optra Color 40 Lexmark T522

Lexmark Optra Color 45 Lexmark T620

Lexmark Optra Color 1200 Lexmark T622

Lexmark Optra E Lexmark T63X

Lexmark Optra Ep Lexmark W812

Lexmark Optra K 1220 Lexmark W820

Lexmark print servers

MarkNet™ S MarkNet N2004fl-MTRJ

MarkNet Pro 1 MarkNet N2004fl-SC

MarkNet Pro 3 MarkNet N2004fl-ST

MarkNet XL MarkNet N2501e

MarkNet XLe MarkNet X2011

MarkNet N2001e MarkNet X2012

MarkNet N2000t MarkNet X2030

MarkNet N2002e MarkNet X2031

MarkNet XI Lexmark C750 Ethernet

MarkNet N2003fx-MTRJ Lexmark C910 Ethernet

MarkNet N2003fx-SC Lexmark T520 Ethernet

MarkNet N2003fx-ST Lexmark T522 Ethernet

Lexmark T520 SBE Ethernet Lexmark W820 Ethernet

Lexmark T620 Ethernet Lexmark X820 Ethernet

Lexmark T622 Ethernet

Lexmark printers



 

System requirements
12

Universal Printer Support (UPS)

Brother HL-1470N Series NEC SuperScript 1800

Brother HL-1650 / 1670N Series QMS Magicolor 2

Brother HL-1870N Series QMS Magicolor 6100

Brother HL-2460 Series Ricoh Aficio 180

Canon GP 200D Ricoh Aficio 270

Canon ImageCLASS C2100 Ricoh Aficio 350/355

Canon ImageRunner 330 Ricoh Aficio 450/455

Canon ImageRunner 400 Ricoh Aficio 550

Canon ImageRunner 500 Ricoh Aficio 650

Canon ImageRunner 600 Ricoh Aficio 750

Canon ImageRunner 2800 Ricoh Aficio 850

Canon ImageRunner 5000i Ricoh Aficio 1045

HP 2000 C Ricoh AP3800C Series

HP 2500 C Tektronix Phaser 350

HP 8550 MFP Tektronix Phaser 550

HP 8550GN Tektronix Phaser 560

HP Business InkJet 2250TN Tektronix Phaser 740/750

HP Color LaserJet 4500 Tektronix Phaser 750DX

HP Color LaserJet 4550 Series Tektronix Phaser 780GN

HP Color LaserJet 8500 Tektronix Phaser 840DX

HP LaserJet 2100 Series Tektronix Phaser 850

HP LaserJet 2200 Xerox DocuColor 4CP

HP LaserJet 3300 MFP Series Xerox DocuColor 2006

HP LaserJet 4000 Series Xerox Document Centre 220/230

HP LaserJet 4050 Series Xerox Document Centre 240 ST

HP LaserJet 4100 MFP Series Xerox Document Centre 265 ST

HP LaserJet 5000 Series Xerox Document Centre 332

HP LaserJet 5/5M Xerox Document Centre 340/440

HP LaserJet 5si Xerox Document Centre 440

HP LaserJet 8000 Series Xerox DocuPrint 4512

HP LaserJet 8100 Series Xerox DocuPrint C55/C55mp

HP LaserJet 8150 Series Xerox DocuPrint N17
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HP LaserJet 9000 Series Xerox DocuPrint N2025

HP Mopier 320 Xerox DocuPrint N2125

IBM InfoPrint 20 Xerox DocuPrint N24

IBM InfoPrint 21 Xerox DocuPrint N2825

IBM InfoPrint Color 8 Xerox DocuPrint N32

IBM Network Printer 12 Xerox DocuPrint N3225

IBM Network Printer 17 Xerox DocuPrint N40

Konica KL-3015 Xerox DocuPrint N4025

Kyocera FS-1700 Xerox DocuPrint N4525DX

Kyocera FS-1750 Xerox DocuPrint NC60

Kyocera FS-1800 Xerox Phaser 790

Kyocera FS-3750 Xerox Phaser 860

Kyocera FS-3800 Xerox Phaser 1235

Kyocera FS-7000 Xerox Phaser 2135DT

Kyocera FS-9000 Xerox Phaser 3400

Kyocera FS-9100DN Xerox Phaser 5400

Minolta Color PageWorks Xerox Phaser 6200

Minolta PageWorks 20 Xerox Phaser 7700DN

Minolta-QMS Magicolor 2200 Xerox Phaser 8200

Minolta-QMS Magicolor 3100

Universal Printer Support (UPS)
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2 Using MarkVision Professional

Installing MarkVision Professional

Before you install

Before you install the MarkVision Server: 

1 Make sure you have 70MB of hard disk space available for a complete installation. 

2 Decide where to install the MarkVision Server. 

You must install one MarkVision Server on the network. 

Note: You may install any of the other packages on the same workstation running the 
MarkVision Server, although this is not necessary. 

Where to install MarkVision components

If your devices are distributed across a local area network (LAN) or wide area network (WAN), 
network traffic increases as users try to access them. With MarkVision, you can choose where to 
install components, letting you reduce network traffic. 

To minimize network traffic and improve performance, install the MarkVision Server on a host that 
offers relatively high-speed access to users and to the devices you want to monitor.

Installable components

MarkVision supplies several installable components

• MarkVision Application—Installs the primary client application that is used to manage your 
devices. This application requires a MarkVision Server to be available on the network. 

• MarkVision Server—Installs the necessary files to set up the MarkVision Server. 

• MarkVision Messenger—Installs the MarkVision Messenger Web-based utility. 

• MarkVision Web Client—Installs a Web browser-based version of the MarkVision Client to 
the MarkVision Server, allowing you to access MVP from a remote location using a browser. 
Because the installation process is operating system-specific, there are different install 
packages that can be used for this version of the client. These files include: 
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• Windows Web package 
• Mac OS X Web package
• UNIX Web package (Java runtime environment is required) 

When you are installing the MarkVision components, a dialog box will appear that shows the 
hierarchy in which the different components can be installed. You can install the MarkVision 
application and the MarkVision Server separately; the application only requires that one instance of 
the MarkVision Server be installed somewhere on the network, not necessarily on the same 
machine. 

Note: For Windows based operating systems, you must also be sure to select the parent 
branches in the hierarchy if you want to include any items located in a sub-branch. 

Installation notes

In order to run the web client, you must first enable your web browser to support Sun’s Java Runtime 
Environment (JRE) by installing the Java Plug-in. In Windows environments, the plug-in is provided 
and the user is automatically prompted to install it the first time they run the MarkVision Web Client. 

Note: The MarkVision Client program does not require the installation of the browser 
plug-in.

The MarkVision Web Server is automatically installed along with the MarkVision Server.

MarkVision Professional relies on technology that is specific to the web server that it provides, so it is 
not possible to use other web servers to make MarkVision available. During installation, you are 
given the choice to make the MarkVision web server the default server on the machine. This allows 
the browser-based application to access the server from the standard port (80), which requires no 
additional numbering in the URL. When this option is rejected, the MarkVision Web Server listens for 
HTTP requests on a non-standard port (9180) that should not interfere with any other existing web 
servers. 

Note: If another web server is listening on port 80, the option to have the MVP Server 
listen on the default web port (80) is not present.

As an administrator, if you already have a department or corporate web server on which you want to 
publish the URL to access MarkVision Professional or Messenger, it is recommended that you create 
a URL on your current web server that automatically forwards the user’s browser to the URL used by 
either tool.

Installing MarkVision Professional for Windows and Mac OS X systems

There are two ways to install MarkVision Professional on your system: 

• CD installation

Insert the CD into your CD-ROM drive and follow the instructions on the screen. 
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• Web site installation

If you chose the Web Installation Package option, the MarkVision Professional Web 
Installation Package is downloaded to your server. 

For a successful Web site installation

• The operating system must be supported by MarkVision Professional. 
• You must use a supported web browser. 

To uninstall MarkVision Professional

To remove MVP from a Windows system, select MarkVision Professional in the Add/Remove 
Programs application. For a Mac OS X system, run the MarkVision Professional Uninstaller 
application located in Applications/Utilities. This will shut down both servers that are running and 
then remove all aspects of MarkVision Professional. 

Windows default file locations

MarkVision Application

C:\Program Files\Lexmark\MarkVision Professional

MarkVision Server

C:\Program Files\Lexmark\MarkVision Server\Granite

Macintosh default file locations

MarkVision Application

/Applications/MarkVision Pro Client

MarkVision Server

/Applications/Utilities/MarkVision Pro Server Control

Installing MarkVision Professional for UNIX systems

MarkVision Professional supports multiple UNIX operating systems. 

HP-UX

1 Download the MVP package file from the Lexmark Web site and place the package file in the 
/tmp directory.

2 Start the System Administration Manager by typing /usr/sbin/sam &. 

3 On the Sam areas screen, click Software Management. 
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4 Click Install Software to Local Host. The SD Install-Software Selection screen and Specify 
Source dialog appear. If these dialog boxes do not appear, go to the Actions menu and click 
Change Source to open the Specify Source dialog. 

5 Make sure that the hostname of the computer that you are installing on appears in the Host 
Name text box. If it does not, enter the hostname or select it from the list. 

6 In the Source Depot Path field, enter the full path to the HP-UX package file:

/tmp/markvision-pro-hpux1x.pkg 

7 Make sure Change Software View is set to All Bundles. If it is not: 

a Click Change Software View.

b On the Software View screen, click All Bundles. Then, click OK.

8 On the Specify Source screen, click OK. 

9 Select the bundles you want to install. There are two ways to mark the packages: for installing 
all the MarkVision packages at once or installing individual packages.

To install all the MarkVision packages at once

a Click the MarkVisionPro bundle.

b Go to the Actions menu, select Mark for Install. This marks all the MarkVision 
Professional packages for install.

c Skip to the next step. 

To install individual packages

a Double-click the MarkVisionPro bundle. This displays the server and client packages. 

b Double-click each package bundle to view its contents. 

c For each package that you want to install, click the package, then go to the Actions menu 
and select Mark for Install. A “Yes” appears beside each package that you have selected 
to install. 

10 Go to the Actions menu and select Install (analysis).

11 Click OK. A confirmation message appears. 

12 Click Yes to start the installation. 

Note: If the HOME variable was not set for root when you started SAM, an error message 
appears. Ignore the message and click OK. 

13 During Installation, select Logfile to view the installation log. 

Important: Make sure there are no errors or warnings during installation. 

14 When installation is finished, select Done to return to the SD Install-Software Selection 
screen. 
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15 Click File, and then click Exit to return to the Software Management screen. 

16 Enter the following in the command line and answer any questions that may appear: 

/opt/lexmark/setup.mvjserver

This file will set up the MarkVision Server users for use with the MarkVision Professional 
server. 

AIX

1 Download the MVP package file from the Lexmark Web site and place the package file in the 
/tmp directory. 

2 Type the following in the command line and press Enter:

smit install_latest

3 When prompted to enter the input device directory for software, enter: 

/tmp/markvision-pro-aix.pkg

4 All packages are normally installed by default, though you can choose to install some 
packages individually. To install only the packages you want: 

a Under the Software to Install option, select List.

b Select the packages you want to install.

c Select Do.

5 Specify any other install options, such as COMMIT.

6 Select Do to begin installing MarkVision Professional. A message is displayed when 
installation is finished. 

7 Enter the following in the command line and answer any questions that appear: 

/usr/lpp/markvision_pro/setup.mjserver

RedHat Linux; SuSE Linux

1 Download the MVP package file from the Lexmark Web site and place the package file in the 
/tmp directory. 

2 Unzip and untar the file:

$ tar zxvf /tmp/markvision-pro-linux-glibc2-x86

3 Add cd to the package directory:

$ cd /tmp/markvision-pro-linux-glibc2-x86

4 In the command line, change your default directory to the package directory:

cd /mnt/cdrom/packages/markvision-pro-linux-glibc2-x86
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5 Install either all or individual MarkVision components:

• To install all MarkVision components, issue the command: 

rpm -irh *.rpm

• To install individual MarkVision Professional components, specify the file name of the 
MarkVision Professional component that you want to install. For example, to install just 
the MarkVision Professional Server, issue the command:

rpm -irh markvision-pro-MVJserver-*.i386.rpm

6 Type the following on the command line and answer any questions that appear:

/usr/local/lexmark/setup.mvjserver

Solaris SPARC systems

1 Download the MVP package file from the Lexmark Web site and place the package file in the 
/tmp directory. 

2 Start the package installation program: 

pkgadd -d /tmp/markvision-pro-solaris2-sparc.pkg

3 When a list of available packages appears: 

a If you want to install all the packages, type all and then press Enter.

b If you want to install individual packages, type each package number separated by a 
comma and then press Enter. For example: 1,2,3. 

4 Follow the prompts and answer any questions that appear on the screen: 

a To accept the defaults, press Enter.

b To answer yes/no questions, type y, n, or ?, and then press Enter. 

c When a message appears telling you the installation was successful, type q to quit.

Note: You must install all the packages in the same location. 

5 Type the following on the command line and answer any questions that appear:

/opt/local/lexmark/setup.mvjserver

Unix general file locations

MarkVision Application

/usr/mvp/bin (executable files)

/usr/mvp/etc (configurable files)

/usr/mvp/lib (archive/library (JAR) files) 
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MarkVision Server

/usr/mv_pro/bin (executable files)

/usr/mv_pro/etc (configurable files)

/usr/mv_pro/lib (archive/library (JAR) files)

Setting up the MarkVision Professional UNIX Server

Once the MarkVision Professional package is installed on a system, a setup script must run to 
complete the installation process. This script is installed at:

<install-dir>/setup.mjserver

The MarkVision Server must be run as a standard system daemon. It collects information about 
network attached devices, such as printers and print servers. For security reasons, this daemon must 
be run as a normal user with no special privileges. Therefore, we recommend using an existing user 
ID or to create a special user ID for this daemon to run as. 

The default user ID is user nobody. Most modern UNIX systems ship with this ID pre-installed. If you 
want to change it and use a different ID (for example markvision), create the user ID before running 
the setup script. 

The setup script checks if the MarkVision Server is currently running, and if so will exit, prompting the 
user to stop the server using the appropriate command. If the server is not running, it prompts for the 
user ID and verifies its validity. Once the user ID is verified, the MarkVision Server starts. 

The following shell scripts are used during the MarkVision Server setup and startup process:

• /usr/mv_pro/bin/findJava
• /usr/mv_pro/bin/MvService
• /usr/mv_pro/bin/MvWebService

FindJava

This script is used by multiple scripts to locate the appropriate version of Java Virtual Machine on the 
system. This script attempts to find the path to the “java” binary in standard system locations. If the 
JVM is not found in standard system locations, it tries to search the PATH environment variable for 
the JVM. If the search for the appropriate JVM fails, it exits with an error message informing the user 
that a suitable JVM was not found. It also indicates the appropriate JVM version(s) required to run 
the MarkVision Server software. 

If you believe a suitable JVM is on the system, make sure it is in your PATH and run the /usr/mv_pro/
bin/findJava script again. This creates a symbolic link from /usr/mvp_java to the Java home directory 
(JAVAHOME). 

For example, if the full path to the appropriate “java” binary is: 

/usr/local/java/bin/java

The Java home directory is “/usr/local/java.”
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Therefore, the link can be created as follows:

# /bin/ln -s /usr/local/java /usr/mvp_java

MvService

The /usr/mv_pro/bin/MvService command is used to start and stop the MarkVision Professional 
Server as a Unix daemon. 

$ man MvService

MvWebService

The /usr/mv_pro/bin/MvWebService command is used to start and stop the Tomcat Web server. 
Tomcat is the official reference implementation of the Java Servlet 2.2 and JavaServer Pages 1.1 
technologies. (For more information on the Tomcat web server, visit the official Tomcat Web site at: 
http://jakarta.apache.org/tomcat/index.html.)

The MvWebService process is used to provide the following services over HTTP:

• Serve the MarkVision Professional web client
• Provide access to MarkVision Messenger
• Provide browser-based access to MarkVision Professional documentation

To access the above features, point your browser to port 9180 of the machine where you installed 
MarkVision Professional Server with the following URL: 

http://<markvision-server-host>:9180/markvision

or

http://<markvision-server-host>:9180/messenger

NFS mounting the MarkVision Professional UNIX client

You can install MarkVision Professional on one host computer and export the file system to other 
host computers for mounting. Using NFS eliminates the need to perform individual installations at 
each workstation and conserves disk space. 

We recommend to install both the MarkVision Professional UNIX client and server packages on one 
host computer. The host computer can then be designated as an NFS server, as well as the 
MarkVision Server. Client workstations can then mount the MarkVision Professional directory on the 
server, and run the MarkVision Professional UNIX Client locally.

Important: The NFS server and client workstations must use the same operating system. 

To NFS mount the MarkVision Professional UNIX Client

1 Configure the server.

a Make sure you’re logged on with root user authority.

b Install the MarkVision Professional UNIX client. Follow the directions for the operating 
system you’re using. 

http://jakarta.apache.org/tomcat/index.html
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c Export the directory where you installed the MarkVIsion Professional UNIX Client. For 
example: /opt/lexmark/ or /usr/local/lexmark/

2 Configure MarkVIsion Professional on the local workstation.

a Make sure you’re logged on with root user authority. 

b NFS mount the MarkVision Professional directory from the server (Refer to your operating 
system documentation for mounting instructions).

c Run the install script in the mounted MarkVision Professional directory. The script creates 
symbolic links to this directory in /usr/mvp. The following example uses /mnt as the 
mount point. 

cd /mnt/lexmark

./MVJclient.link

To uninstall the MarkVision Professional UNIX Client

1 Run the uninstall script which removes the symbolic links to the mounted directory from /usr/
mvp. 

./MVJclient.unlink

2 Unmount the MarkVision Professional directory. Refer to your operating system 
documentation for unmounting instructions. 

Removing MarkVision Professional packages

With root authority, you can remove MarkVision Professional using these utilities:

Depending on the utility on your system, either mark the packages for removal after you start the 
program, or provide the names of the packages you want to remove in the command line. Refer to 
your operating system documentation for more information. 

Removing remaining directories

Package removal utilities usually do not remove directories shared by more than one package. The 
following two software packages share the same directory structure (install-directory>markvision)

• Enhanced Printer Drivers
• MarkVision Professional

Operating system Package removal tool

HP-UX sam

IBM AIX smit

RedHat; SuSE Linux rpm -e 

Sun Solaris SPARC pkgrm
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After removing all the previously mentioned MarkVision packages (if one or more were installed), 
some directories may need to be removed manually. 

To see if any directories remain after removing all the MVP packages, check the directory where you 
installed MarkVision. By default, MVP installs in either /opt/lexmark/ or /usr/local/lexmark/.

Installing MarkVision Professional into CDE

You can integrate MVP into the Common Desktop Environment (CDE). Integrating installs CDE 
icons, actions, and online Help. 

To integrate MarkVision Professional into the CDE:

1 Make sure you have root user authority.

2 Type the following in the command line:

/usr/bin/mark2cde

On some CDE systems, the MarkVision Professional CDE icons may not appear after installing the 
MarkVision Professional CDE snap-in. The icons appear after logging out and logging back in again. 

If you encounter problems while running mark2cde manually, try running it again using the Korn shell 
(ksh) rather than the Bourne shell (sh). 

Removing the MarkVision Professional CDE:

When removing the MarkVision Professional client package, you must manually remove the CDE 
snap-in. 

To uninstall the CDE snap-in, as root, type the following in the command line: 

# /usr/bin/mark2cde -d

Installing MarkVision Professional into KDE

You can integrate MVP into the K Desktop Environment (KDE). Integrating installs KDE icons, 
actions, and online Help. 

To integrate MarkVision Professional into the KDE:

1 Make sure you have root user authority.

2 Type the following in the command line:

/usr/bin/mark2kde

You must restart KDE after installing the KDE snap-in to see the icons. 

If you encounter problems while running mark2kde manually, try running it again using the Korn shell 
(ksh) rather than the Bourne shell (sh). 
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Removing the MarkVision Professional KDE:

When removing the MarkVision Professional client package, you must manually remove the KDE 
snap-in. 

To uninstall the KDE snap-in, as root, type the following in the command line: 

# /usr/bin/mark2kde -d

Note: MarkVision Professional is currently not supported under KDE 2 environments due 
to a reported bug in Sun’s Java Virtual Machine 1.3.x. However, the supported 
Linux platforms under KDE 1 have been found to function correctly. For details on 
the bug, refer to Sun’s Java Web site at:

http://developer.java.sun.com/developer/bugParade/bugs/4392053.html 

Installing MarkVision Professional into GNOME

You can integrate MVP into the GNU Network Object Model Environment (GNOME). Integrating 
installs GNOME icons, actions, and online Help. 

To integrate MarkVision Professional into the GNOME:

1 Make sure you have root user authority.

2 Type the following in the command line:

/usr/bin/mark2gnome

On some GNOME systems, the MarkVision Professional GNOME icons may not appear after 
installing the MarkVision Professional GNOME snap-in. The icons appear after logging out and 
logging back in again. 

If you encounter problems while running mark2gnome manually, try running it again using the Korn 
shell (ksh) rather than the Bourne shell (sh). 

Removing the MarkVision Professional GNOME:

When removing the MarkVision Professional client package, you must manually remove the GNOME 
snap-in. 

To uninstall the GNOME snap-in, as root, type the following in the command line: 

# /usr/bin/mark2gnome -d

Finding space to install MarkVision Professional

Some operating systems require you to install MarkVision Professional in a particular directory. If the 
file system containing that directory is full, you can create a symbolic link that points to a directory in 
another file system. The symbolic link appears to be a real directory, but the files are actually 
installed in the location the link points to. 

http://developer.java.sun.com/developer/bugParade/bugs/4392053.html
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For example, to appear to install MarkVision Professional in /disk2/lexmark, do the following:

1 Create a directory in the location where you want the packages to be installed. For example, 
to install the /disk2 file system:

mkdir /disk2/lexmark

2 Create a symbolic link pointing to the directory you created. For example:

ln -s /disk2/lexmark /opt/lexmark

Upgrading from previous versions of MarkVision

Prior versions of MarkVision for Windows are easily upgraded by running the installation program. All 
prior folders, filters, devices, and so on are retained with the new version. If you are upgrading from 
an earlier release of MarkVision Professional for Unix systems, make sure you upgrade your 
MarkVision clients and server(s) together. 

Note: When upgrading MarkVision Professional for Unix systems, you should remove the 
currently installed package, as well as the saved configuration. These files are 
stored in /var/spool/markvision. Remove all files except the vir_queues and 
vir_devices directories. Removing these directories will break any existing print 
queue created with Enhanced Printer Drivers (MV Print). 

For versions earlier than MarkVision Professional 6.0, such as MarkVision for Intranets, or classic 
MarkVision, We recommend that you uninstall the old version before attempting a new installation. 

To export devices from classic MarkVision:

1 In Classic MarkVision, under the Configure - TCP/IP option, click the Manage Print Server 
List button. Then, click Export to File.

2 Enter the location where you want the file stored. 

3 Once you have exported the file, you need to edit the file to accommodate the current MVP 
format. Configure the file path to match the following naming convention: 

IP <Ip address or hostname> <read community name> <write community name>

4 Install your new version of MVP 10.1, and then click Load in the Device Discovery task.

5 Select your updated file. Click OK. The list is imported for discovery. 

Getting started

When you open MarkVision Professional for the first time, select the server you want to use. Enter 
the computer/hostname or IP address of the Machine running the MarkVision Server or click Browse 
to locate it, and then click Connect. 

After the setup wizard appears, use the steps outlined in the wizard to: 
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• Configure MarkVision Professional to your specific needs
• Locate and organize devices across your network 
• Establish a device management strategy that lets you quickly begin working with MarkVision

Note: To prevent MarkVision Professional from opening the setup screen at startup, 
check the Do not show me this setup window again box. 

To configure MarkVision Professional

If you are new to MarkVision Professional, completing these steps in the setup wizard helps you to 
get the most out of what MarkVision has to offer. Depending on your needs, some steps may not be 
necessary. 

1 Find your devices. Create device profiles and find printers and print servers on your 
network. 

2 Organize your devices. The setup wizard provides a default set of installation folders that 
you can install on your system, or you can use the Folder Configuration task to organize your 
devices into folders based on criteria you choose. 

3 Customize your device information. The setup wizard provides default sets of custom 
tables and views, or you can use the Custom Views and Custom tables tasks to customize 
the ways that you view your devices.

• Creating custom tables. Use the Custom Tables task to create a table of specific device 
information. A custom table can be exported as a comma separated variable (.csv) file, 
which can be opened by spreadsheet or word processing software. 

• Creating custom views. Use the Custom Views task to create multiple views that let you 
view only the printer attributes you want to see. 

4 Secure access to available information. Use the User Accounts and User Groups task to 
grant or restrict access to tasks and devices. 

Invoking the MarkVision Client

Select which version of the MarkVision client you want to use. You can use either the MarkVision 
Client Application or the MarkVision Web Client. 

Starting the MarkVision Application

In the application form, the client is installed locally, so it can be launched just like any other program. 
For example, in Windows environments, you can double-click the MarkVision Professional icon on 
the desktop, or go to Start → Programs → Lexmark → MarkVision Professional. 
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Accessing the MarkVision Web Client

Since the MarkVision Web Client is browser-based, you will need to open your browser and point it to 
the MarkVision URL: 

http://<your server>/markvision

In this URL <your server> is the IP address or hostname of the machine that is running the 
MarkVision Server. 

Note: If during installation you did not make MarkVision Professional the default server 
on your machine, you must use the non-standard port number (9180) in the URL: 
http://<your server>:9180/markvision.

Starting the MarkVision Application on a UNIX system

If you are using MarkVision Professional from a UNIX system, you can access MVP from either a 
command line or the MarkVision Professional Web Client. 

Using the MVP UNIX Client from the command line:

If it is supported by your workstation, you can use the X Window system. To use MarkVision with X, 
you must set the display variable. 

1 Set the DISPLAY environment variable

• Korn (ksh) and Bourne (sh) shell users type the following: 

Display=hostname:0.0

export DISPLAY

Where hostname is the name of your workstation.

• C shell users type the following: 

setenv DISPLAY disphost:0.0

2 If you are running the MarkVision Professional UNIX client on a different host computer than 
your X server, make sure the remote host has permission to access your display. For 
example, if the MVP UNIX client is running on the host flora, type the following in the 
command line: 

xhost + flora

3 Type mvp in the command line, and then press Enter.

Using the MVP UNIX client from a web browser:

Once the MarkVision web server is configured, a MarkVision web client starts when you connect to 
/markvision on that server with your browser. 



 

Basics
28

For example, to start a MarkVision web client on a web server whose IP address is 190.168.112.21, 
point your browser to the following URL:

http://190.168.112.21:9180/markvision

To manage your devices with MarkVision Professional

After you have configured MarkVision to suit your needs, you can begin exploring the powerful 
management features that MarkVision has to offer. 

• Using filters. Use the Filters task to create criteria filters that can be saved and applied to 
folders. 

• Using device policies. Use the Device Policy tasks to uniformly configure many devices at 
once. 

• Scheduling tasks. Use the Scheduling task to schedule certain tasks. 

• Collecting information about print jobs. Use the Job Statistics task to gather and store 
information about each print job sent to a specific printer. 

• Gathering information about printers. Use the Printer Inventory task to gather and store 
information about the devices in your organization. 

• Managing plug-ins. Use the Software Update task to install and remove plug-ins for 
additional device support. 

The All Tasks list 

There are many more device management tasks available in MarkVision Professional than those 
listed above. For a complete listing, see the All Tasks list.

Basics

Home screen

When you log in to MarkVision Professional, the Home screen appears, which lists things you can 
do with MarkVision Professional. These lists contain some of the most commonly used functions 
available in MarkVision Professional. You can customize these lists by selecting Customize next to 
the list's category name. 

The MarkVision Professional toolbar is directly below the menus. The icons in this toolbar represent 
frequent tasks. To add or remove tasks from the toolbar, select MarkVision Personal Settings from 
the menus. With the Personal Settings task, you can also configure the level of message detail and 
other miscellaneous options. 

Note: Frequent tasks are also available when you right-click a device in a context menu. 
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Layout

The left pane of the MarkVision Professional window is typically used to select one or more devices. 
You can find the devices you want by using the Quick Find feature or Folders. (See Creating folders 
for help setting up and populating folders.) 

Task information for the selected device(s) appears in the right pane. 

Multi-select capability

When you are presented with a list of items, such as printers, you can multi-select them using the 
Control or Shift key. This lets you edit an attribute for all the selected devices at one time. For 
example, if the contact name for a group of printers has changed, you can multi-select those 
particular printers and change the contact name for those printers only, without having to change 
each one individually. 

Enhanced accessibility

MarkVision Professional offers alternative keyboard navigation in accordance with industry 
standards. MarkVision’s user interface and subsequent task oriented dialog boxes can be navigated 
exclusively with a keyboard. The navigational features include using the Alt key to activate mnemonic 
(underlined character) options in the Task bar menus, accelerator key combinations that invoke menu 
items without navigating the menus, and the ability to “Tab” through the different components of a 
dialog screen. 

MarkVision tasks

There are a variety of tasks you can perform using MarkVision Professional, and a variety of ways to 
access them:

• The All Tasks list on the MarkVision Professional Home screen

• The menus (for example: Actions → Personal Settings) 

• The MarkVision Professional toolbar (also available by right-clicking a device) 

• The MarkVision Professional (MVP) Home screen 

Note: Because of its customizable user environment, your version of MarkVision may 
contain a different set of tasks than those listed below. 
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All Tasks list

The following table briefly describes the tasks available from the All Tasks list. 

Task Function

About View the version information of MarkVision.

Add Devices Search networks and add devices to MarkVision 
Professional.

Administrative Settings Change settings regarding how MarkVision Professional 
obtains information from the server.

AppleTalk View or modify the AppleTalk network settings. 

Application Links Configure external applications to launch from MarkVision. 

Contact Name and 
Location

View or modify the contact name or location for a specified 
device. 

Custom Media - Custom 
Paper Name 

View or modify custom paper names.

Custom Media - Custom 
Paper Type

View or modify custom paper type settings.

Custom Media - Paper 
Loading

View or modify custom paper loading settings.

Custom Media - Paper 
Texture

View or modify custom paper texture settings.

Custom Media - Paper 
Type Bin

View or modify custom paper bin settings.

Custom Media - Paper 
Weight

View or modify custom paper weight settings.

Custom Tables - Create/
Manage

Configure and export tables of device information.

Custom Views - Create/
Manage

Create custom views with multiple pieces of information.

Device Discovery 
Profiles

Create discovery profiles to search attached networks and 
add discovered devices to MarkVision Professional.

Device Discovery 
Results

Display device discovery results based on specific 
discovery profiles.

Device Policy - Check 
Device Conformance

Determine if selected devices are conforming to device 
policies.

Device Policies - Apply Apply created policies to selected devices to enforce 
settings.

Device Policies - Create/
Manage

Manage list of device policies to quickly set or change 
device settings (such as print quality), or enforce those 
settings.
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Drivers and Utilities (On 
the Web)

Open the Lexmark driver and utilities Web page.

E-mail Destinations Create and manage e-mail destinations for selected 
devices.

Emulators View emulator (printer language interpreters) settings for 
selected printers.

Fax (Printer) View or modify a printer's fax settings.

Fax Destinations Create and manage fax destinations for selected devices.

Fax Settings View or modify the fax settings for a specified device.

Feature Overview 
(Printers)

View printer data, such as identification information, 
capabilities, code levels, and page count information.

Feature Overview (Print 
Servers)

View print server data, such as identification information, 
protocol, and fax settings.

Filters View or edit the list of saved filters, which can be used to 
limit the number of devices displayed.

Finishing View or modify a printer's finishing settings, such as 
copies, collate, and resolution.

Firmware (On the Web) Open a Web page to obtain print server upgrades for 
supported print servers.

Firmware Download 
(Print Server)

Upgrade your print server firmware.

Folder Configuration - Organize devices using folders.

- Filter folder contents based on printer attributes.

Font Cartridges View information about any installed font cartridges.

FTP Destinations Create and manage FTP destinations for selected devices.

General Settings 
(Printer)

View or modify printer settings, such as job timeout, 
emulation, and power saver.

General Settings (Print 
Server)

View or modify print server settings, such as job timeout, 
contact name, contact locations, and network speed.

Generic File Download Download miscellaneous files such as postscript files, 
universal configuration files (UCF), or font files to one or 
multiple devices on your network. 

Home Return to the Home screen.

Home Page (On the 
Web)

Open the Lexmark home page on the Web.

HTTP Settings View or modify a device's HTTP settings.

Inputs View settings for paper trays and other printer inputs.

Job Statistics: Trend 
Analysis

Gather and store information about your print jobs.

Task Function
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Job Timeout (Print 
Server)

View or modify a device's job timeouts.

LexLink View or modify the LexLink network settings.

Map Place device icons on a graphical representation of your 
organization to illustrate the distribution of your printers.

MarkVision Messenger 
Launch

Open the MarkVision Messenger application.

MFP - Backup 
Configuration 
Information

Create a backup copy of all configuration settings on MFP 
device(s). The backup copy will be used to restore the 
settings during disk recovery or code update operations. 

MFP - Default Copy 
Settings

View or modify Copy Settings for an MFP device.

MFP - Default Scan to 
E-mail Settings

View or modify Scan to E-mail Settings for an MFP device.

MFP - Default Scan to 
Network Settings

View or modify Scan to Network Settings for an MFP 
device.

MFP - Features View feature information for multifunction devices.

MFP - General Settings View or modify General Settings for an MFP device.

MFP - LDAP Settings View or modify LDAP Settings for an MFP device.

MFP - Manage Function 
Access

View or modify Function Access for an MFP device.

MFP - OptraImage Job 
Statistics Settings

View or modify OptraImage™ job statistics settings for an 
MFP device.

MFP - Specify External 
Destination File

View or modify OptraImage external destination settings 
for an MFP device.

MFP Status View the current status conditions of multifunction devices.

Names of Devices View or modify a device's name.

NetWare View or modify the NetWare network settings.

Network Time Protocol Synchronize a print server's internal clock with the 
MarkVision Server.

Operator Panel Display a functional operator panel for a specified printer.

Operator Panel LCD Display the LCD display from the operator panel for a 
specified printer.

Operator Panel Lock/
Unlock

Remotely lock and unlock a printer operator panel.

Output Bin Names View or modify a printer's custom bin names.

Page Counts View a printer's current page count information.

Paper Settings View or modify a printer's paper settings.

Task Function
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PCL View or modify a printer's PCL™ settings.

Personal Settings Personalize MarkVision to fit the way you work.

Picture of Printer Display a picture of a selected printer.

Ports View or modify a device's ports.

PostScript View or modify a printer's PostScript™ settings.

PPDS View or modify a printer's PPDS settings.

Printer Inventory Gather and store information about your printers.

Printer Statistics Display statistical data for selected printers in a table 
format.

Profile Destinations Create and manage profile destinations for selected 
devices.

Property Tag View or modify a property tag (user identification) for a 
printer.

Publications (On the 
Web)

Open the Lexmark publications Web page.

Refresh Devices Refresh cached information for selected printer and/or print 
server devices.

Registration (On the 
Web)

Open the Lexmark printer registration Web page.

Remove Devices 
(Advanced)

Lets administrators remove all or specified devices from 
the system. 

Reset Reset a specified printer or print server.

Scheduling Specify times to automatically initiate certain tasks.

Service Location 
Protocol

Enable or disable the Service Location Protocol (SLP) 
function on a print server.

SNMP Traps View or modify a device's SNMP Trap Destination.

Software Update 
(Manage Plug-Ins)

Install and remove new MarkVision Professional plug-ins 
for additional device support.

Status of Printer View the current status conditions of selected printers.

Status Overview View the LCD panel, picture of printer, and status of printer 
for selected devices.

Storage Devices View information about a printer's storage devices, such as 
hard disks and flash memory.

Supplies (On the Web) Open a Web page where printer supplies can be ordered.

TCP/IP View or modify the TCP/IP network settings.

Technical Support (On 
the Web)

Open a Web page where technical support for Lexmark 
products can be obtained.

Toner/Ink Levels Monitor toner or ink levels for a specified printer.

Task Function
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User's Guide Opens the MarkVision Professional User's Guide. 

User Accounts and User 
Groups

Create or edit individual accounts or account groups to 
restrict access to certain tasks.

Web Page (Print Server) Open a Web page displaying settings for a selected device.

Task Function
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3 Configuring MarkVision Professional

Adding and removing devices

MarkVision Professional lets you search your network for devices, such as printers and print servers. 
You can then schedule and configure discoveries to suit your needs. Once devices are "discovered," 
their locations are stored on the MarkVision Server, and, by default, populate the All Devices folder. 

To discover devices, you must first create a profile (or profiles) for the devices you want to discover. If 
you have upgraded from a previous version of MarkVision, any devices that have previously been 
discovered and stored on the server are available in version 10.1 as a profile labeled Full Discovery. 

Device profiles define the range of devices that you want to discover, letting you select devices 
specific to your current needs. You can create multiple device profiles, each with a different set of 
devices. Each profile can then be saved and reused for future discoveries. 

Creating discovery profiles

1 On the MarkVision Home screen, go to MarkVision → Device Discovery and select 
Manage Discovery Profiles, or select Device Discovery Profiles from the All Tasks menu. 

2 Click New.

3 Enter a name for the profile that you want to create. For example, enter My Network.

4 Enter any comments about the profile.

5 Click Add to add devices to the Include list. The Discovery Profile dialog box appears. 

6 Select the type of address, and enter the range from which the devices will be included. 
Specify one or more of the following: 

• TCP/IP address, subnet, or hostname 

IP addresses should be in the dot notation form of X.X.X.X, for example, 192.168.12.34. 
To perform a network discovery (search a subnet), use a zero(0) or asterisk (*) as a 
wildcard. For example, 192.168.0.0 would search the entire Class B network, finding all 
devices whose address begins with 192.168. 

• You can also search for a device using its hostname. 
• After you enter the address information, you can enter SNMP community names to 

change the read or write access privileges. To Change privileges from the default 
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value (public), enter the new community names in the appropriate field. The 
community names are case-sensitive.

Note: This changes the MarkVision community name, not the print server community 
name. To change the print server name, refer to your print server documentation. 

• click Include to add the addresses or hostname to the Devices to Include on the 
Server box. 

• TCP/IP address range 

Enter the TCP/IP address range, beginning with the From: box and ending with the To: 
box, and then click Include. 

With this option you can also enter SNMP community names to change the read or write 
access privileges. To Change privileges from the default value (public), enter the new 
community names in the appropriate field. The community names are case-sensitive.

Note: This changes the MarkVision community name, not the print server community 
name. To change the print server name, refer to your print server documentation. 

• IPX network

This is the network number on which your print server resides. It is an eight-digit 
hexadecimal number; for example, 000C2194. If the print server resides on the same 
network as your MarkVision Server, enter 00000000 (zeros) for the network number. If 
you do not know the network number of your print server, you can find it on the print 
server setup page, under the NetWare settings. After you enter the address information, 
click Include to add the addresses to the Devices to Include on the Server box. 

7 Click OK to return the Manage Discovery Profiles screen. The entered devices are now listed 
under the Include tab. 

8 Click Apply.

Note: If you want to discover a device or group of devices without creating a profile, see 
Adding devices.

Discovering devices

1 Go to MarkVision → Device Discovery → Manage Discovery Profiles.

2 Select the profile from the Discovery Profiles window that encompasses the devices that 
you want to discover. 

3 Click Start. 
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4 MVP communicates with the devices included in the selected profile. To stop a discovery at 
any time, click Stop Discovery. 

Note: Performing a discovery with the Full Discovery profile, or any profile that includes 
all of the devices on your network, requires a large amount of CPU usage. Running 
a full discovery can render the MarkVision Server virtually unusable while the 
discovery is executing. 

Including and excluding devices

The Include and Exclude tabs on the Manage Discovery Profiles screen display lists of devices that 
are to be included or excluded from the profile’s current device list respectively. When creating a 
profile, if there are certain devices that were listed in the device range that you entered that you do 
not want to include in the profile, select the Exclude tab and add that device to the exclude list. You 
can then use the Remove and Remove All buttons to remove devices from the include/exclude lists.

Examples: 

• If you are the network administrator and know the addresses of routers and computers on 
your network and do not want to have extraneous traffic created by the discovery, add the 
addresses of your routers and computers to the exclude list. 

• If you want to manage all printers on the 70 subnet except for the secretary's printer, add the 
70 subnet in your include list, and then add your secretary's printer address in your exclude 
list. 

Advanced features 

To configure advanced device discovery features, click the Advanced tab from the Device Discovery 
main window. The following are features that may be customized for an advanced device discovery 
profile:

• Query each address: MarkVision Professional sends an individual query to each address 
specified in the device discovery. 

• SLP Multicast: MarkVision Professional sends a single SLP request over the network. An 
SLP Multicast only generates a brief spike in network traffic, and discovers only Lexmark 
devices. 

• Also search for other vendors' devices: MarkVision Professional discovers non-Lexmark 
devices on the network. 

• Maximum number of seconds to wait for a device to respond: This specifies the 
maximum amount of time to wait for a device response during device discovery. Adjust this 
value if devices are not responding or network traffic is heavy. 

• Maximum number of seconds to wait for responses to an SLP Multicast: This specifies 
the maximum amount of time to wait for a print server response during an SLP Multicast. 
Adjust this value if print servers are not responding or network traffic is heavy. Only supported 
print servers are discovered during an SLP Multicast. 



 

Adding and removing devices
38

• Number of retries to perform when a device does not respond: This specifies the number 
of attempted retries before an address is ignored. Setting this value beyond 1 does not 
normally provide greater accuracy. Setting this value to zero (0) disables retries, which may 
substantially increase speed with little impact on accuracy. 

Note: Each Discovery Profile can have its own advanced settings.

Import / Export buttons 

You can use the Import and Export buttons to import or export profiles for discovery. They are saved 
in the industry standard XML format. 

Load / Save buttons

The Save button saves the information in the Devices to Include on the Server and Devices to 
Exclude from the Server fields as a text file, which can later be retrieved using the Load button. 

Scheduling 

To schedule discoveries, select the Schedule task from the All Tasks menu. 

You can schedule device discoveries to occur on a daily, weekly, or monthly basis. This ensures that 
the list of devices MarkVision Professional manages is always current. If your device discoveries are 
network-intensive, you can schedule them to occur at off hours, when network traffic is at a minimum. 
Select the profile that you want to use for the discovery. Then, choose the initial day from the Start 
time: box, and select the time at which the discovery is to occur. You can then decide to have the 
discovery occur once, daily, weekly, or monthly. When all of your selections are made, click OK. For 
more information on scheduling, see Scheduling tasks.

Naming devices

After you have found all of the devices that you want to manage with MarkVision Professional, you 
can establish the name that MarkVision will use to identify the device. 

MarkVision uses a specific algorithm to determine a device’s name. First, it looks to see if a name 
has been assigned to it from the Names of Devices task. Then MarkVision looks for the following in 
order: TCP/IP address, hostname, IPX address, Serial Number, and then Property Tag. The order of 
this list can be changed using the Administrative Settings task. 

From the All Tasks menu on the MarkVision Home screen, select Custom Names. With this task, 
you can select the devices that you want, and enter any name you want for the device. For example, 
My Printer. 

Note: You must have administrative access to name devices or to use the Administrative 
Settings task. 
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Adding devices

In some situations you may want to discover some devices without creating a profile. In these 
situations you can use the Add Devices task to discover individual or small groups of devices. 

To use the Add Devices task:

1 Select Add Devices from the All Tasks menu, or select MarkVision → Device Discovery → 
Add Devices on the MVP Home screen.

2 Select a specific device or devices from the list of existing devices on the screen, or click Add 
to enter a new device address, and then click OK.

3 Click Start to begin the discovery. 

You can also select the Exclude tab to select devices from an existing profile that you do not want to 
include in the discovery.

Select the Advanced tab to reset additional discovery settings.

Note: You can save any new groups of devices that you establish with the Add Devices 
task as a new discovery profile by clicking Save as Profile.

Device discovery results

After you have performed a device discovery, you can view the discovery’s results. You can access 
device discovery results under MarkVision → Device Discovery → Device Discovery Results. 

You can filter the results both by date and device discovery profile. When the Dialog Discovery 
Results dialog box appears, enter the run date when the discovery was performed, and select the 
discovery profile. The discovery results contain a header, a range of discoveries, and a summary 
displaying the “devices not found.” 

Removing devices from the server

If there are any devices that you no longer want to associate with your network, and that you do not 
want to include in any subsequent discoveries, you can remove them from the server’s list of 
managed devices with the Remove Devices task. The Remove Devices task is available by clicking 
the Remove Devices icon, located between the navigation buttons and the frequent task icons on 
the MVP toolbar, in the MarkVision menu under Device Discovery → Remove Devices 
(Advanced), or by selecting Remove Devices (Advanced) under the All Tasks menu. 

To remove devices from the MarkVision Server, browse the existing device folders or use the Quick 
Find feature to locate the devices that you want to remove. When you have selected all of the 
appropriate devices, click the Remove icon on the MarkVision taskbar. The selected devices are 
removed from the MarkVision Server. 
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Creating folders

Folders are a way of grouping devices by particular conditions, such as low toner, or by particular 
options, such as duplexing. By grouping devices in this manner, it is much easier to find the devices 
you want. 

MarkVision Professional is shipped with a pre-existing root folder, All Devices, which cannot be 
deleted. All additional folders you create are listed below this root folder. However, you do not have to 
create additional folders to use MarkVision. 

To create folders: 

1 Select Folder Configuration from the All Tasks menu, or click MarkVision → Folders. 

2 Select the parent folder. 

3 Click New from the Folder window. 

4 Enter a name for the new folder. 

5 Add devices to the folder. There are two methods to populate a folder with devices (printers or 
print servers): 

• Manual selection 
• Filter 

To add devices manually, select the Manual Selection tab, and then select the devices you 
want. 

To add devices through the use of filters, select the Filter tab, and configure your filter.

6 Click Apply. 

Note: You can also create folders by right-clicking a parent folder, and then clicking New. 

Manual selection is very useful when dealing with a small number of devices, or if there is a specific 
device that you want to include in the folder. Filters are the most efficient method for managing a 
large number of devices. A filter limits the number of devices visible in a folder to only those exhibiting 
the characteristics you specify, letting you select a limited number of devices from the multitude that 
are connected to your network. Select multiple filter characteristics for an increasingly narrow printer 
selection. For example: 

Jane is in charge of keeping the printers in her company up and running. She would like to 
know which ones presently need human intervention or will need attention very soon. To 
accomplish this, she creates a folder that populates by using filters. In the Device Type list 
box, she selects Printers. She clicks Advanced, then selects Status: Message, Equal To, 
Paper Jam. She clicks New to create another filter criterion, and then selects Status: 
Message, Equal To, Toner Low. Once Jane applies the filter, the folder will only display 
printers with paper jams or low toner. 

Note: When organizing a large number of printers based on frequently changing criteria 
(such as paper jams), we recommend that you use filters rather than folders to 
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observe the effected devices. The effort needed by the MarkVision Server to 
continuously update and repopulate folders can dramatically slow your system. As 
a result, populating folders based on static criteria saves network resources on 
larger printer networks. 

You can also use the Load and Save buttons to import or export a filter set. The Save button saves 
the filter criteria you have selected as a file which can later be retrieved using the Load button. For 
more information on creating filters, see Using filters. 

Using filters

The Filters screen lets you create a filter set, which limits the number of devices visible in a list or 
folder to only those exhibiting the characteristics you specify. Filters can have multiple criteria, 
allowing for specific device selection. When you create a folder, you have the option to create a filter 
for that particular folder, or load a previously saved filter and apply it to the folder. A folder with no 
filter contains all the devices of its parent folder. There are two types of filters:

• Basic: Choose one or more common device characteristics as filter criteria. 

• Advanced: Create multiple filter criteria, some of which require characteristics to be typed 
into the Value list box. For example, if you have a brand XYZ printer model (that is not in the 
list of available printer models) with Job Timeout set at 90 seconds, you could specify both: 

In the above example, both the "90" and "XYZ" would be manually typed into the Value list box. 

You can also filter devices by conformance (or lack of conformance) with specific device policies. To 
create a Device Policy Conformance filter, select the parameter Policy Conformance and select 
either Is in conformance with or Is not in conformance with for the operation. The value will be 
one of the device policies on the MarkVision Server (unless no policies have been created yet). For 
example: 

Note: Only printers that have all values specified in Jane’s Printer Policy are visible if this 
filter is used. 

Click New to add additional filter criteria; click the red X to remove filter criteria. 

Parameter Operation Value

Model: Equal To XYZ

Parameter Operation Value

Job Timeout: Equal To 90

Parameter Operation Value

Policy 
Conformance

Is in conformance with Jane’s Printer Policy
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When multiple conditions are selected

• Clicking the All conditions must be met radio button means that every device must meet 
every criterion displayed by the filter. 

• Clicking the At least one condition must be met radio button means that devices must meet 
only one condition displayed by the filter. 

Device Type

• You can choose to have your filter include printers, print servers, or both. Specify this in the 
Device Type list box. 

Example 1: Basic filter

John is in charge of keeping the printers in his company up and running. He would like to know which 
ones presently need human intervention or will need attention very soon. To accomplish this, he 
creates a Basic filter. 

1 Since John is only interested in printers, he selects Printer from the Device Type list box. 

2 From the Select Filter Type list, he selects Status. 

3 He then selects All Errors and All Warnings. 

4 He then clicks Apply, and the filter is created. 

5 To save the filter, he clicks Save Filter As. 

Once John applies the filter to a folder, that folder only contains printers displaying an error or 
warning state. He can then select another MarkVision task such as Status of Printer to view the new 
folder he created, letting him see which printers are currently exhibiting errors or warnings. 

Example 2: Advanced filter

Mary would like to create and save a filter that only displays monochrome printers with firmware code 
level 1.10.17. To accomplish this, she creates an Advanced filter. 

1 Since Mary is only interested in printers, she selects Printer from the Device Type list box. 

2 She then selects the following: 

Parameter Operation Value

Color Equal To Monochrome
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3 She clicks New to create another filter criterion, and then selects the following from the 
Parameter and Operation list boxes. She must manually type in the firmware code (1.10.17). 

4 Since Mary's printers need to meet both conditions, she clicks the All conditions must be 
met radio button. 

5 To save the filter, Mary clicks Save Filter As. 

Once Mary applies the filter to a folder, that folder only contains monochrome printers with a 
firmware code equal to 1.10.17.

Creating user accounts and user groups

The User Accounts and User Groups task lets you create and manage user accounts and account 
groups that define the user’s access to the devices that MarkVision manages. 

Accounts are designed as a security measure. By having accounts, you limit user access to specific 
tasks. Similarly, you can place several accounts into account groups. This lets you distribute a range 
of privileges across a number of accounts. 

To access the User Accounts and User Groups task, select User Accounts and User Groups from 
the All Tasks menu on the MarkVision Home screen. When adding accounts or account groups, a 
wizard dialog box appears to guide you through the process. 

The MarkVision Setup Wizard helps you create some initial accounts. You do not have to add 
accounts to use MarkVision, but we recommend that you at least create an administrator account to 
ensure the security of your devices. 

Only administrators or designated users can add or delete accounts. As people join or leave your 
staff, you may need to create or update MarkVision user accounts. If you do not want a specific 
account to have full administrative rights, you can either specify the appropriate privileges when the 
account is created or assign the account to a group that contains rights to only the tasks you allow. 

Create an administrator account

1 In the Accounts section of the users table, click Add. 

2 Enter the administrator account name and password. 

3 Confirm the password that you entered. The indicator light to the right of the field turns green 
and enables the OK button when the password confirmation is entered correctly. 

4 Click OK. 

Note: Before you create user accounts, you must create an administrator account. 

Parameter Operation Value

Printer Firmware 
Code

Equal To 1.10.17
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Create a new user account

1 In the Accounts section of the users table, click Add. 

2 Enter the account name and password. 

3 Confirm the password that you entered. The indicator light to the right of the field turns green 
and enables the Next button when the password confirmation is entered correctly. 

4 Click Next.

5 Select the privileges that will be available to the account from the Available Privileges window. 

6 Click the (>) buttons to add or remove the selected privileges to and from the user account. 

7 Click Next. 

8 Select all the devices that the user account will have access to. 

9 Click Finish.

Create an account group

By putting user accounts into groups, you can ensure that your user accounts are configured 
uniformly. If, for example, you wanted a group of users to only have access to certain tasks on certain 
devices, you could create an account group to: 

• Specify the user accounts to be included in the group 

• Specify the tasks to be available to the group 

• Specify the devices to be available to the group 

For example: 

Note: If you assign task privileges for your users with the User Accounts task, and then 
add the user accounts to a group, your users will have access to tasks granted by 
both the account and the group. For example, if a user account is given access to 
the Device Discovery task, and that user account is a member of an account group 
that does not grant access to the Device Discovery task, that user account will still 
have access to Device Discovery.

Group Access rights Devices

Help desk Reset printers and print servers; Change printer and print 
server settings

All devices

Executive 
secretaries

Monitor toner and paper supplies Respective department 
printers only

Department B73 Change printer settings; View status; Discover printers Department printers only



 

Assigning user privileges
45

Create a user group

1 In the Groups section of the users table, click Add. 

2 Enter the group name.

3 Select the user accounts that will be assigned to this group. 

4 Click Next.

5 Select the privileges that will be available to the user group from the Available Privileges 
window. 

6 Click the (>) buttons to add or remove the selected privileges to and from the user group. 

7 Click Next.

8 Select all the devices that the user group will have access to. 

9 Click Finish.

Edit or remove an existing user account or group

• To edit a user account or group

1 Double-click the account or group that you want to edit, or select the desired account or 
group, and then click Edit in the corresponding section of the table.

2 Enter your user account and password.

3 Adjust the account or group attributes accordingly.

• To remove a user account or group

1 Select the account or group that you want to remove, and then click Remove.

2 Enter your user account and password into the confirmation prompt, and then click OK.

Note: Removing groups may affect a user’s access rights. You cannot recover a group 
once it has been removed. 

Assigning user privileges

MarkVision administrators can restrict the access of other MarkVision users so they can only perform 
certain tasks on certain devices. To control user privileges, create accounts and account groups 
(User Accounts and User Groups task). When you set up a group, determine what tasks the group 
can perform, or assign them individually when creating an account. You can also determine which 
devices the users can view.
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Administrator privileges

If you decide to create accounts in MarkVision, you are required to create an administrator account. 
This administrator account is authorized to perform all MarkVision tasks on all devices. 

Note: If no accounts (administrator or otherwise) are created, all MarkVision users have 
authorization to perform all tasks. 

Designated user privileges

For non-administrator accounts, user privileges and accessible devices are either defined by the 
parameters specified when the user account was created, or the group assigned to the user. 
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4 Managing devices 

Creating custom views

With the Custom Views task, you can create multiple views that let you view only the printer attributes 
you would like to see. 

To create a custom view

1 Select Custom Views - Create/Manage from the All Tasks menu. 

2 Click New. 

3 Give the custom view a name. 

4 Choose the printer attributes you would like to add to this view by clicking the New 
Component icon (next to the Name field). 

5 As you select the attributes, blocks indicating the size of the data appear in the window below. 
Arrange the blocks so that each one can be easily viewed. 

6 Click Apply. 

Once created, custom views are available from the All Tasks list. A custom view is listed by the name 
you gave it in the steps above. You can also select your custom view by clicking View → Custom 
Views → <custom view name> from the menu bar. 

To edit a custom view

1 Select Custom Views - Create/Manage from the All Tasks menu. 

2 Select the custom view to change. 

3 Change the custom view as appropriate. 

4 Click Apply. 
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Creating custom tables

Custom Tables provide an easy interface with which to view device information. After it has been 
configured, a custom table can be exported as a comma-separated variable (.csv) file, which can be 
opened by spreadsheet or word processing software. 

Creating a custom table

1 Select Custom Tables - Create/Manage from the All Tasks menu. 

2 Click New. (To edit an existing custom table, click the table's name.) 

3 Give your table a descriptive name. 

4 From the Available Columns box, select the items to be included in the table. You can use the 
Ctrl or Shift keys to select multiple items. 

5 Click the arrow to move the selected items into the Columns In Use box. You can then 
arrange the columns by using the up and down arrows. For example, if you wanted Duplex 
Option to be the first column of the table, you would move it to the first position in the 
Columns In Use box. 

6 Choose how to sort the rows of your table. For example, if you choose Color from the Sort 
Custom Table By list, and then click Ascending, your table lists color printers first. 

7 If you want your Custom Table to be a Frequent Task, click the Frequent Task box in the 
upper right corner. Your custom table is then available from the MarkVision Professional 
toolbar or when you right-click a device. 

8 Click Apply. 

Your Custom Table is also available by selecting View → Custom Tables → <your custom table>. 

Viewing a custom table

1 Select the devices you want to appear in the table. 

2 Select your custom table from the All Tasks menu, or select View → Custom Tables → 
<your custom table>. Your custom table appears. 

3 To print your custom table, click Print. To export your custom table, click Export. 

4 To edit a custom table while viewing it: 

• Reorganize columns by dragging them. 
• Click a column heading to sort by that column. 
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• Right-click the table to save your changes or reset to the default column and sort 
order. 

Note: These changes do not change the table settings as defined in the Custom Tables 
task; they are unique to each user account. To change the default column and sort 
order, you must use the Custom Tables task. 

Using device policies

A device policy contains saved printer or print server settings. When a policy is created, it can then 
be applied to one or more devices. The device's settings are then reconfigured to match the settings 
listed in the policy. Any setting that is not applicable to the device is not applied. 

Creating a device policy is useful for the following reasons: 

• To enforce a standard configuration across a set of devices. For example, Power Saver 
should be set to Off for all printers, and Printer Timeout set to 20. 

• To use multiple configurations for a device. For example, one policy could set Toner Saver on 
and low resolution for draft printing, while another policy could set Toner Saver off and high 
resolution for final document printing. 

The following tasks are associated with device policies: 

• Device Policies - Create/Manage. Create, edit, or remove a policy. 

• Device Policies - Apply. Apply a policy to one or more specified devices. 

• Device Policies - Check Conformance. Determine if selected devices are conforming to 
device policies.

• Scheduling. Specify days and times to automatically apply a policy or perform a 
conformance check. 

Create a device policy

Let's say you want to duplicate the printer settings you have configured for one printer to several new 
printers. 

1 Select the Device Policies - Create/Manage task. 

2 Click New and select the based on a specific device option. 

3 Select the device whose settings you want to copy and then click OK. 

4 Give the new policy a meaningful name, such as "Company Printer Settings." 

5 Click Apply. 
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Apply the device policy

Select the Device Policies - Apply task. 

Select the printers you want to update with the new policy from the device list. If the printers you want 
to update do not show up in the list, you can search for them. (See Finding the devices you want 
for help.) 

Select the device policy you created ("Company Printer Settings") from the Device Policies list and 
click Apply Policy. 

Check device policy conformance

The Device Policies - Check Conformance task displays a selected device’s current settings in 
comparison to its applied device policy. 

To access the task: 

1 Select Device Policies - Check Conformance from the All Tasks list. 

2 Select the device you want to check for policy conformance.

3 Compare the present device settings with the policy settings.

Scheduling device policies

You can set up a schedule telling MarkVision when to apply specific policies on one or more devices. 
This might be useful for resetting defaults for your devices each day or checking a device's 
conformance to a policy. For scheduling information, see Scheduling tasks. 

Note: Not all devices support the device policy task. Unsupported tasks appear with a line 
through the device name. 

Scheduling tasks

The Scheduling feature lets you perform a task such as Printer Inventory or Job Accounting on a 
specific day at a specific time. Each task can have multiple schedules. 

You can schedule the following tasks using MarkVision: 

• Job Statistics
• Generic File Download
• Printer Inventory 
• Device Policies: Apply Policies 
• Device Policies: Check Conformance
• Firmware Download 
• Device Discovery
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• Remove Devices

To schedule a task:

When you access the Scheduling task, the scheduling screen appears with a list and calendar 
showing all presently scheduled events. 

1 Select Scheduling from the All Tasks menu or click Actions → Scheduling. 

2 Click Add. 

3 Select the event you want to schedule and type a description of the event. Click Next. 

4 Select the date and time you want the event to take place. You can schedule an event to 
occur on a daily, weekly, or monthly basis. If your scheduled event is to occur on a weekly or 
monthly basis, select the days on which you want it to occur. 

5 Click Next.

6 Select the type of database (if applicable) and the database’s location (URL) where you want 
to store the results of the scheduled event.

7 Enter your user name and password in the appropriate fields. Click Next.

8 Select discovered devices from the device folders window, or use the Quick Find feature to 
locate new devices and place them in the selected devices window using the (>) buttons. 

9 Once you have selected all of the devices that you want to associate with the event you are 
scheduling, click Finish. 

The scheduled event now appears in the calendar window of the Scheduling task. 

Note: To schedule a device discovery, use the Device Discovery task. 

Collecting information about print jobs

You can use MarkVision Professional to gather and store information about each print job sent to a 
specific printer (a task called Job Statistics: Trend Analysis). You can then view the collected 
information using a database tool or an application specifically designed to interpret and display the 
information. 

Enabling Job Statistics tells MarkVision Professional to collect information about each print job sent 
to a specific printer. This includes information such as job size, job duration, output bins used, and so 
on. 

You can use the information gathered by the Job Statistics task to answer questions such as: 

• Which printers are getting the most use? 
• Which departments are using the printer(s) the most? 
• How long does it take to print a job? 
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• What is the toner level in the printer(s)? 

Note: The statistical information derived from the Job Statistics task provides you with a 
reasonable estimate of your printers’ operational status. It is not intended for 
generating billing statements based on printer performance. 

Enable Job Statistics

1 Select Job Statistics: Trend Analysis from the All Tasks menu. 

2 Select the database you want to use. 

3 Enter the username, password, and connection path (URL) for the database you plan to use. 

Note: The URL is the path to the database used to monitor this server. MarkVision 
currently supports the following databases: Access, Oracle, and SQL Server, as 
well as CSV format (Comma Separated Variables). The following table shows the 
path styles used for each type of database. 

4 Select the type of job statistics to use and whether or not status alerts should be 
documented. 

5 Select the characteristics that you want to use to locate the printer. 

6 Add the printer(s) for which you want to enable job statistics to the Selected Printers box. 
You can select printers from folders or perform a quick find to find the printers you need. 
Select multiple printers by using the Ctrl or Shift key. 

7 Click Apply. 

Note: To enable Job Statistics, use Scheduling tasks. 

 

Database Description

Oracle The default is the path to the MarkVision Server. If the database is installed on a different 
server, change the URL field appropriately, using the path style below: 

<database driver>@<database server's IP address>:<database port>:<database 
instance (memory area)> 

For example: jdbc:oracle:thin:@117.124.46.113:1521:orcl 
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Gathering information about printers

You can use MarkVision Professional to gather and store information about the devices in your 
organization. You can then view the collected information (printer inventory) using a database tool or 
an application, such as MarkTrack, specifically designed to interpret and display the information. 

Use the information gathered by the printer inventory process to answer questions such as: 

• How many printers do we have on our network? 
• What types of printers do we have? 
• What options are installed on our printers? 
• What is the lifetime page count of our printers? 
• What are the print job statistics for our printers? 

Enable printer inventory

1 Select Printer Inventory from the All Tasks menu. 

2 Select the database you want to use. 

3 Enter the username, password, and connection path (URL) for the database you plan to use. 

Note: The URL is the path to the database used to monitor this server. MarkVision 
currently supports the following databases: Access, Oracle, and SQL Server, as 
well as CSV format (Comma Separated Variables). 

4 Add the printer(s) from which you would like to collect printer inventory to the Selected 
Printers box. You can select printers from folders or perform a quick find to locate the printers 
you need. (Select multiple printers by using the Ctrl or Shift key.) 

5 Click Apply. 

If you would like printer inventory to run at a specific time, select Scheduling from the All Tasks 
menu. 

Access, 

SQL Server 

<database driver>:<DSN> 

For example: jdbc:odbc:yourdsn 

DSN is a Data Source Name, which must be created prior to using Job Statistics or Printer 
Inventory. Use your ODBC configuration in Windows' Control Panel to create a DSN. 

Note: Exporting this information through an ODBC interface is only supported in a 
Windows environment. 

CSV CSV format provides you the option to export your printer data into a text file formatted to 
accommodate database fields. Enter the directory address where you want the text file to 
be created on your network or computer. 

For example: C:\temp\printerinventory\home

Database Description
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The following table shows the path styles used for each type of database.

Managing plug-ins

You can download and install new MarkVision plug-ins on your MarkVision Server for added device 
support. The plug-ins you install will, in most cases, also contain downloadable client components. 
Relevant client information then downloads to your workstation when you log into the MarkVision 
Server. 

To access the Software Update (Manage Plug-Ins) task, select MarkVision → Software Update 
(Manage Plug-Ins) on the MVP Home screen. 

The Manage Plug-Ins screen lists all of the plug-ins that are currently installed. A list of all of the 
currently installed plug-ins is also available on the About MarkVision Professional screen, which you 
can access through the About task. If there are no plug-ins listed, you can download the current 
updates from the Lexmark Web site at this address: www.markvisionprofessional.com. 

The manage plug-ins screen then provides two management options: Remove and Install New. 

• Remove 

The Remove option lets you uninstall a selected plug-in. First select the plug-in(s) that you 
want to uninstall from the list. You can select multiple list entries by holding down either the 
Shift or Control (Ctrl) keys while clicking on the desired plug-ins. Click Remove. This removes 
the selected plug-in(s) from the server and the client. The uninstall script on both the server 
and the client then determines if a restart is needed. 

Database Description

Oracle The default is the path to the MarkVision Server. If the database is installed on a different 
server, change the URL field appropriately, using the path style below: 

<database driver>@<database server's IP address>:<database port>:<database 
instance (memory area)> 

For example: jdbc:oracle:thin:@117.124.46.113:1521:orcl 

Access, 

SQL Server 

<database driver>:<DSN> 

For example: jdbc:odbc:yourdsn 

DSN is a Data Source Name, which must be created prior to using Job Statistics or Printer 
Inventory. Use your ODBC configuration in Windows' Control Panel to create a DSN. 

Note: Exporting this information through an ODBC interface is only supported in a 
Windows environment. 

CSV CSV format provides you the option to export your printer data into a text file formatted to 
accommodate database fields. Enter the directory address where you want the text file to 
be created on your network or computer. 

For example: C:\temp\printerinventory\home

http://www.markvisionprofessional.com
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• Install New 

When you click Install New, a dialog box appears that lets you select a plug-in from the 
directory to be installed on the server. Once a plug-in file has been selected, a confirmation 
screen appears, containing more specific information about the plug-in(s) that you have 
selected, and provides you with the option to proceed with installation. The successful 
installation of a plug-in is then announced to all clients connected to the server through the 
MVP message window located at the bottom of the MVP Home screen. 

After a plug-in has been installed on the server, the MVP client receives information on the plug-in 
versions that have been installed and details on which plug-ins contain downloadable client 
components. If new client components are available, the client determines if the server and itself are 
compatible and then automatically downloads the client component of any plug-ins that it does not 
already have. 

Note: If the client and server are not compatible because the client contains a component 
that the server does not have, a warning message is issued and any incompatible 
client components are removed. 

Generic file download

The Generic File Download task lets you download miscellaneous files from the MarkVision Server 
to one or multiple devices on your network. As a result, various file types, including universal 
configuration files (UCF), can be instantly distributed to any devices that MarkVision manages. 

The Generic File Download task is available under the All Tasks menu, or by clicking Settings → 
Generic File Download on the MarkVision Professional Home screen. 

You can also schedule the download of files by using the Scheduling task.

Using the Generic File Download task

1 Select the file(s) that you want to download from the list of available files on the MarkVision 
Server. If there is a file from another location that you want to include in the list, click Load to 
browse for local files that you can load onto the server. 

2 Click the (>) button to move the files to the file management table on the right side of the 
screen. 

Note: Clicking Remove removes the selected files from the list of available files, 
subsequently removing the files from the server’s file store, as well as the file 
management table.

3 In the file management table, click the Target Directory tab to select the file’s target location. 
Then, click the Remote Directory tab to specify the directory name.

4 Click Next. 

5 Select the device or devices to which you want to download the selected file(s). 
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Destination management

MarkVision Professional’s destination management tasks provide the ability to more accurately 
manage the destinations to which the devices on your network send information. MVP provides a 
destination management task with which you can easily add or edit specific destinations for each 
protocol that your network devices use to transmit information. 

The destination management tasks are: 

• Fax destinations 

• E-mail destinations

• FTP destinations

• Profile destinations

Using destination management tasks

1 Select one of the four destination management tasks from the All Tasks menu, or select 
Settings → MFP → Destinations from the MVP home screen. 

2 Using either Quick Find, or by choosing a specific device (or devices) from existing folders, 
select the devices that have the destination types you want to manage. A table will appear in 
the right side of the screen displaying the existing destinations. If the selected devices have 
no current destinations, the table will be empty. 

3 To add a new destination, click Add. Enter the appropriate information in the dialog box, and 
then click OK. 

4 Click Apply.

5 The listed destinations are added to the selected devices. 

You can also cut, copy, or paste definitions by right-clicking destinations listed in the 
destination management table. 

Destination Fields

Fax Name, Fax number, Shortcut (If applicable)

E-mail Name, E-mail address, Format, Content, 
Color, Resolution, Shortcut (If applicable)

FTP Name, Server, Login, Password, Password 
confirmation, Path and filename, Format, 
Content, Color, Resolution, Shortcut (If 
applicable)

Profile Name, Address, Port
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Editing destinations

1 Select one of the four destination management tasks from the All Tasks menu, or select 
Settings → Destinations from the MVP Home screen. 

2 Using either Quick Find, or by choosing a specific device (or devices) from existing folders, 
select the devices that have the destination types you want to manage. A table will appear in 
the right side of the screen displaying the existing destinations. If the selected devices have 
no current destinations, the table will be empty. 

3 Select the destination you want to edit. Click Edit. 

4 Enter the updated information in the dialog box, and then click OK.

5 Click Apply. The edited destinations are updated for the selected devices. 

Removing destinations

1 Select one of the four destination management tasks from the All Tasks menu, or select 
Settings → Destinations from the MVP Home screen. 

2 Using either Quick Find, or by choosing a specific device (or devices) from existing folders, 
select the devices that have the destination types you want to manage. A table appears in the 
right side of the screen displaying the existing destinations. If the selected devices have no 
current destinations, the table will be empty. 

3 Select the destination you want to edit. Click Remove. Clicking Remove All removes all listed 
destinations.

Destinations in device policies

You can also set specific destinations for print servers through the Device Policies task. To set 
destinations for print servers: 

1 Open the Device Policies task and select the print server policy that you want to edit.

2 Expand the MFP folder view and open the Destinations folder. 

3 Click the check box for the destination type that you want to edit, and then click Edit. 

Note: When policies containing destinations are applied to devices that already contain 
destinations, the device’s existing destinations are first deleted. 

4 The Destinations Management dialog box opens beneath the selected destination. Edit the 
destination list accordingly. Click Hide to close the Destination Management dialog. 
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Changing printer settings

The easiest method of changing printer settings is by selecting the item you want to change from the 
Settings menu or the All Tasks list. Select one or more printers and change the settings 
appropriately. 

You can create a device policy to coordinate multiple settings and save them as a unit. A policy can 
then be applied to one or more devices at a time, or saved for future use. See Using device policies 
for more information. 

Printer statistics

The printer statistics task displays statistical data for selected printers in an easy to read table format. 

Viewing printer statistics

1 Select Printer Statistics under the View menu on the MarkVision Professional Home screen. 

2 Select the printers or folders from which you want to view statistical data. 

A separate table for each type of statistical data is displayed with a list of the selected printers 
and their related values. 

You then have the option to print each table or export the data to another location.
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Checking printer status

To check printer status, you can select one of the following options from the View menu: 

• Status of Printer 

• Toner / Ink Levels 

• MFP Status 

• Picture of Printer 

• Page Counts 

• Operator Panel LCD 

• Map 

• Custom Tables 

• Custom Views 

Organizing devices 

MarkVision lets you organize your devices using folders. When you create or edit folders, you can 
specify certain criteria to limit which devices are in a folder. This works like a filter so that only the 
devices you want to appear are in the folder.

For example, if you are responsible for maintaining toner cartridges for printers on the third floor of 
your building, you might create a folder for your printers named "3rd floor." Create a subfolder named 
"Low Toner," specifying that a filter should be placed in it. Click Advanced, then specify the filter 
criteria by selecting Status: Message, Equal To, Toner Low. This causes the "Low Toner" folder to 
display only those printers in need of service due to low toner cartridges. 
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Using filters to automatically populate folders

1 Select Folder Configuration from the All Tasks menu. 

2 Click New to create a new folder, or select a specific folder to edit an existing one. 

3 Enter the name of the new folder. 

4 Select the properties to use in adding filters or devices to the folder. 

5 You can specify a device name or names to further narrow down which devices to show in the 
folder. 

6 Click Apply to apply the specified criteria to the current folder. 

For more information about finding specific printers within a folder, see Finding the devices you 
want.

For more information about filters, see Using filters. 

Viewing a print server's embedded web page

1 Select Web Page (Print Server) from the All Tasks menu, or click Actions → Web Page 
(Print Server) from the menus. 

2 Select the appropriate print server, and then click Launch. 

In this example, one folder groups printers by subnet. Other folders group 
printers by their location, printer type, or department. Using the built-in 
filtering feature, the folders show you only the printers matching the criteria 
you specify. 

• The same printer could appear in multiple folders, 
depending on your needs. 

• The devices in a sub folder are dependent on the members 
of the parent folder. In other words, if you create a sub folder 
called Main under the Building folder, the sub folder can only 
contain the devices that are also in the Building folder. 

• The numbers in parentheses indicate the number of devices 
in that particular folder. 

Subnets

157.175.84.0 (13)

Floor (8)
Building (21)

Printer Type(57)

Duplex (25)

Color (12)
Mono (45)

Location (46)

All Devices

157.175.85.0 (24)
157.175.86.0 (4)
157.175.87.0 (16)

Department (37)
I/S (9)
Accounting (4)
Engineering (18)
Marketing (6)
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3 Your browser opens with an information page for that print server. You see a real-time view of 
the selected printer status. 

Note: Not all print servers have Web pages. 

Viewing all printers 

MarkVision gives you several ways to see all the printers available to you at a glance. 

Create folders and filters

Use the Folder Configuration task to create custom folders to organize your printers. If your printers 
are on a small network, you may only need one folder. However, if your printers are distributed across 
a large network, you can create multiple folders to organize them. 

For example, if your printers are concentrated on a small network within a single building, you could 
create folders for each floor or type of printer. For larger printer networks, you could create a folder 
hierarchy that includes subfolders identifying printers listed by geographical location or by subnet. 

Apply filter criteria to your folders to automatically populate folder contents or to find a specific printer. 
For example, create a folder named "Color," and then select the appropriate filter criteria to show 
only color printers. MarkVision applies the filter and adds only color printers to that folder. The same 
printer can appear in more than one folder, depending on the filters you set. For example, a color 
printer with a duplex unit would appear in both the "Color" folder and the "Duplex" folder. For more 
information on creating folders and using filters, see Organizing devices and Finding the devices 
you want.

Create a map view

You can use the Map task to create a graphical representation that illustrates the distribution of your 
printers by placing a printer icon on a map background relative to your organization. The printer 
status determines the border color of the icon that is displayed. A printer icon with a yellow border is 
in a warning state; a printer icon with a red border is in an error state. For more information on using 
the map feature, see Creating maps. 

Creating maps

With MarkVision's Map task, you can create a graphical representation that illustrates the distribution 
of your devices.

Creating a map

The type of map you create depends on the structure of your organization. If your organization has 
one location with just a few printers, your map could be a simple line drawing or a scanned plan of 
your building with icons marking the printer locations. If, however, you are responsible for many 
printers in various geographies, you might create maps that correspond with the hierarchy of your 
printer folders. For example, you could create a folder for the state where a group of printers are 
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located. Within that folder, you might create a sub folder for the city. Additional subfolders could 
contain printers grouped by the building or floor number. Create a corresponding map for each folder. 

Create maps using any graphics application that saves in JPEG or GIF format. You can create an 
original image or develop your graphic using a scanned image like an area map or building plan. 
Save the image in JPEG or GIF format. You can then select the graphic from the Map task in 
MarkVision. 

Using a map

1 Select Map from the All Tasks menu, or select a folder and click View → Map. 

2 Select a folder. 

3 Click the Map icon in the lower part of the window. Select the map you want to use, or click 
Browse to find the graphic you want to use. 

4 Arrange the device icons on the map image to represent its location in your organization, and 
then click Apply. 

Note: A yellow border around a device icon indicates that the device is in a warning state; 
a red border indicates an error state. 

Monitoring printer supplies

There are several methods you can use to monitor printer supplies. 

If you are responsible for monitoring multiple printers: 

• Select Folder Configuration from the All Tasks menu and create a folder with a filter based 
on the status criteria you are interested in. For example, you could create a folder named All 
Status Errors and Warnings, and configure the filter to display only those devices containing 
status errors or warnings. This folder's contents dynamically changes as devices meet or fail 
to meet the filter criteria. 

• You can also perform a Quick Find to monitor printer supplies. Click the Quick Find tab, and 
under the Select a Field to Search box, select Other. Click Find Parameters to configure the 
parameters of your search. Click Find. The results of your search are displayed. 

• To see at a glance which printers are low on toner, select Status of Printer from the All Tasks 
menu, open a folder, and select the printers you are interested in. 

If you are responsible for monitoring only one printer: 

• Select Status of Printer from the All Tasks list. Choose the appropriate printer from either the 
Quick Find or Folders tab.

Note: MarkVision's Map task displays an icon for each device. These icons give you an 
indication of a device's status. A yellow border around a device icon indicates that 
the device is in a warning state; a red border indicates an error state. 
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Moving the MarkVision Server

As newer hardware becomes available, it may become necessary to move the MarkVision 
Professional Server to another machine. Since MarkVision Professional is extremely customizable, 
you may not want to repeat the process of creating folders, filters, and rediscovering devices. The 
following steps describe a method of creating a backup of MarkVision Professional's customized 
data, and integrating that data onto a new machine. 

1 Stop the MarkVision Server. 

2 Back up the directory in which the customized data files are stored. 

• In Windows, the default directory is: C:\Program Files\Lexmark\MarkVision 
Server\granite\data

• For UNIX, the default directory is: /var/spool/markvision/data 
• For Macintosh, the default directory is: /var/spool/markvision/data 

3 Install the MarkVision Server on the new machine. 

4 Stop the MarkVision Server. 

5 Replace the data files saved in step 2 into the same locations on the new machine. 

6 Restart the MarkVision Server. 

Note: The files listed above do not contain settings for window and frame sizes or 
positional information.

Starting and stopping the MarkVision Professional Server on a Windows system

For Windows 2000: 

1 Go to Control Panel → Administrative Tools → Services and select the MarkVision 
Server. 

2 Click Start/Stop.

Note: You can use the same process to start or stop the MarkVision Web service.

For Windows NT: 

1 Go to Control Panel → Services and select the MarkVision Server. 

2 Click Start/Stop.

Note: You can use the same process to start or stop the MarkVision Web service.
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For Windows XP and Windows 2003 Server: 

1 Go to Control Panel → Performance and Maintenance → Administrative Tools → 
Services and select the MarkVision Server. 

2 Click Start/Stop.

Note: You can use the same process to start or stop the MarkVision Web service.

Starting and stopping the MarkVision Professional Server on a Macintosh system

To start the MarkVision Server, open a Terminal session and type: 

/usr/mv_pro/bin/MvService start

To stop the MarkVision Server, open a Terminal session and type: 

/usr/mv_pro/bin/MvService stop

Starting and stopping the MarkVision web service on a Macintosh system

To start the MarkVision web service, type: 

/usr/mv_pro/bin/MvWebService start

To stop the MarkVision web service, type: 

/usr/mv_pro/bin/MvWebService stop

Starting and stopping the MarkVision Professional Server on a UNIX system

To start the MarkVision Server, type: 

/usr/mv_pro/bin/MvService start

To stop the MarkVision Server, type: 

/usr/mv_pro/bin/MvService stop

Starting and stopping the MarkVision web service on a UNIX system

To start the MarkVision web service, type: 

/usr/mv_pro/bin/MvWebService start

To stop the MarkVision web service, type: 

/usr/mv_pro/bin/MvWebService stop
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Finding the devices you want 

There are numerous ways to find devices using MarkVision. You can search for one device using 
specific criteria, or multiple devices using a variety of methods. 

Note: MarkVision only recognizes devices that have been discovered using the Device 
Discovery task (see Adding and removing devices), or Quick Find by Address. 
Once MarkVision recognizes a device using one of those methods, that device can 
later be found by its other attributes, such as its serial number or a property tag. 

Here are some suggested methods for finding one or more printers in MarkVision: 

• If you know a specific setting for a printer, you can use this attribute to find it. For example, 
you can find a printer using its IP address, name, serial number, or a property tag. First, 
select a task to perform. Using the Quick Find tab, pick the attribute you want to use in your 
search from the Select a field to search list. Type the attribute information in the appropriate 
box, and then select Find. 

You can substitute the asterisk (*) character as a wildcard for unknown information in your 
search. It acts as a placeholder for any number of characters. For example, you could enter 
192.168.12.* as your search criteria. 

• If you monitor only 10 printers in MarkVision, the easiest way to find the one you want is to 
scan the tabs in the Feature Overview task for the feature you want. Select Feature 
Overview (Printers) from the All Tasks list. Choose the Folders tab, and view the folder that 
contains the printers you want to choose from. You can then scan the various features 
columns. Click any column heading to sort the printers according to the criteria you want. 
With only a few printers, you should easily find the printer you are looking for. 

• Let's say, however, that you have 800 printers distributed over a large network, and you need 
to find all the color printers with duplex units. First, scan your folders to see if you already 
have one for color or duplex printers. Otherwise: 

1 Choose the Quick Find tab, and then select Other from the Select a field to search list. 

2 Click Find Parameters.... 

3 Configure the filter to find only color printers with duplex units. 

For more information on configuring filters, see Using filters. 

4 Click OK, and then click Find. A list of any color duplex printers on your MarkVision 
Server is displayed. 

You can also create a folder that automatically populates itself with color printers that have duplex 
units. For help creating such a folder, see Organizing devices. 
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Flashing print servers

Periodically, you may need to rewrite the flash memory inside one or more of your print servers. For 
example, let's say Customer Support recommends you upgrade to a newer or different version of 
firmware to solve a network printer problem. 

You can also flash your print servers to take advantage of new functions available in the latest 
version of firmware. Use MarkVision Professional to flash multiple print servers simultaneously. 

Note: Not all print servers are supported. 

All supported firmware (flash) files are available free of charge from Lexmark's Web site. You can 
access the Web site by selecting Firmware (On the Web) from the All Tasks List, or by visiting 
www.lexmark.com.

To flash Lexmark print servers

1 Download the latest flash files from the MarkVision Professional Web site. Store these files 
in a safe place (C:\temp, for example). 

2 Select the Firmware Download (Print Server) task from the All Tasks list, or click Actions → 
Firmware Download (Print Server) from the menus. 

3 Select the print servers you want to update. 

4 Click New File to find the downloaded files (C:\temp, for example). 

5 Click Start. 

Warning: If the print server is turned off or reset during flashing, it may be damaged. For this reason, 
try to perform flash operations at night, on holidays, or other times when printer traffic is very light. 
Accomplish this using the Scheduling task. 

Formatting storage devices

You can use the Storage Devices task to format a device’s hard disk or flash memory. If you select a 
device in the Storage Devices task, changing the Job Buffer amount causes the hard disk to 
reformat, erasing all files. Likewise, clicking the Format button for either the hard disk or the flash, 
erases all files located in the device’s memory. 

You can only copy or move files within a single device. For example, you can move a file from the 
hard disk to the flash within a printer, but not to another printer. 

Note: If Job Statistics is enabled, the file it creates and stores on the hard disk cannot be 
deleted, therefore not allowing it to format. To format a disk that contains one of 
these files, disable Job Statistics for the device, and then format the disk. 

http://www.markvisionprofessional.com
http://www.lexmark.com
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5 MarkVision Messenger

MarkVision Messenger is a utility that lets you create Actions. An Action defines a command to 
execute whenever an event occurs across a set of devices. Device Status Events are conditions 
signaled by messages like Paper Tray Missing or Toner Low. Folder Events are signaled when 
devices enter and/or exit a particular folder.

During the installation of MarkVision Professional, you are asked to select the components to install. 
To install MarkVision Messenger, check MarkVision Messenger. 

If the MarkVision Server is your default Web server, you can access MarkVision Messenger from any 
browser by entering: 

http://yourserver/messenger 

Where your server is the TCP/IP hostname or address of the workstation on which you installed the 
MarkVision Server. For example, if you installed the MarkVision Server and MarkVision Messenger 
on a workstation with an address of nexus.dev.yourcompany.com, you would enter: 

http://nexus.dev.yourcompany.com/messenger 

Notes:

• MarkVision Messenger requires at least one MarkVision Server to be running on your 
network. 

• If MarkVision Professional is not your default Web server, you will need to add the 9180 port 
number to the Messenger URL: 

http://yourserver:9180/messenger 

Installing MarkVision Messenger

MarkVision Messenger requires at least one MarkVision Server to be running on your network. If you 
choose, you can run MarkVision Messenger multiple times on the same workstation. However, each 
instance of the client must use a different configuration directory.

How does MarkVision Messenger work?

MarkVision Messenger communicates with the MarkVision Server to let you create and configure 
automated responses to printer events. These responses are called Actions. When you create an 
Action, you must specify three things:
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• The type of event your Action will monitor 

• The devices your Action will monitor 

• The type of command your Action will execute 

With MarkVision Messenger, you can create Actions to automate many printer administration tasks. 
For example, you can configure Actions to:

• Keep a log of printer paper jams

• E-mail someone when a specific device condition occurs

• Order supplies for a specific device when messages, such as Toner Low, occur

Event Types

Your Action can be triggered by two types of events:

Device Status Alerts

A Device Status Alert is a notification that something has changed at a printer. For 
example, when you pull a paper tray out of a printer, the printer tells MarkVision 
Messenger that the tray is now missing. This is represented in MarkVision Messenger by 
an event with name = "Paper Tray Missing" and state = "ACTIVE."

When the tray is put back into place, the printer tells MarkVision Messenger that the tray 
is no longer missing. This is represented in MarkVision Messenger by an event with name 
= "Paper Tray Missing" and state = "CLEARED." 

You can configure your Action to respond to an event when its state is "ACTIVE," when its 
state is "CLEARED," or both. If your Action responds to Device Status Alerts, you will be 
prompted to choose the specific device status alerts that will trigger your action.

Printer Folder Alerts

A Folder Alert is generated when printers enter and/or exit a specified folder. For 
example, you could create a folder in MarkVision Professional that contains printers with 
a Toner Level less than 10%, and create an Action in MarkVision Messenger to notify you 
when printers enter this folder. If your Action responds to Printer Folder Alerts, you will be 
prompted to choose a folder.

Device Selection

When choosing the devices your Action will monitor, you have three choices:

All Devices on the MarkVision Server

If your Action will monitor all devices on the MarkVision Server, choose this option.
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Devices in a Specified Folder

If your Action will monitor only a specific folder, choose this option. For example, if you 
were in charge of devices on the third floor, and had configured a folder on the MarkVision 
Server that included these devices, you could limit the number of devices your Action 
monitors by choosing this folder.

Selected Devices

If your Action will monitor only specific devices, choose this option.

Command types

There are four types of commands that your Action can execute:

Send an SMTP e-mail

Your Action, when triggered, sends an e-mail to addresses you specify. These e-mails are highly 
customizable from within MarkVision Messenger. For example, an Action, triggered by a Folder 
Alerts event, could e-mail an administrator when monitored printers enter a "Low Toner" folder. This 
e-mail message could be configured to list the model of printer, its IP address, and the time at which 
it entered the "Low Toner" folder.

Execute a command line on the MarkVision Server

Your Action, when triggered, executes a command line. For example, if you wanted to keep a log of 
offline devices, you could configure your Action to respond to the "Offline" Device Status Alert. Each 
time a monitored device becomes offline, specified information is written to a text file. Like the 
example above, the information MarkVision Messenger writes to this text file is highly customizable. 
For example, you could specify that the text file list the device model, page count, and the time at 
which it went offline.

Execute a command line on a remote host server 

Your Action, when triggered, executes a command line on a remote host server. In order to execute 
command lines on a remote host server, the rexec client must connect to a rexec server on the 
remote host server.

Furthermore, you can specify whether to perform commands conditionally or repeatedly, and how to 
execute them. You can have your Action execute its command:

• Only after a specified delay period. 

For example, if your Action sends an e-mail message when a printer goes offline, you can 
delay the execution of the command for a specified amount of time. This way, if the printer 
returns online during the delay period, the e-mail will not be sent. See Delaying Event 
notifications for more information.

• After additional conditions have been met. 

For example, if your Action is triggered by a Paper Tray Missing event, but you only want to 
execute the command when the event occurs for Tray 3, you could write a custom filter to 
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specify that your Action only respond when Tray 3 is removed from monitored printers. See 
Custom filters for more information.

Send device status alerts to a Tivoli event server

MarkVision Messenger contains a custom event adapter that integrates with Tivoli's event 
management console. This event adapter lets administrators use the Tivoli event console to monitor 
printer events across a range of devices in real time. In order for Tivoli to display printer events, you 
must first setup the Tivoli event adapter by creating an action in MarkVision Messenger. 

What are Actions?

Actions are associations that let you execute event-driven commands. They can be set up to occur 
automatically, as well as conditionally or repeatedly. You can specify which commands MarkVision 
Messenger executes when device status events, such as Paper Tray Missing or Toner Low, occur, 
or when devices enter and/or exit a specified folder on the MarkVision Server. 

See How does MarkVision Messenger work? for more information about using Actions.

Simple Filters

By using the Simple Filter you can set your Action to execute its command when a device is added to 
a folder, removed from a folder, or both. For example:

If you create a folder that contains printers whose page count is greater than 10,000, 
once a printer's page count exceeds that amount, the printer is added to that folder.

If you create a folder that contains printers with a flash device installed, and someone 
removes the flash from the printer, it is removed from that folder.

By using the with a delay of: option, you can delay the execution of your Action until a device has 
been in or out of the folder for a specified amount of time.

Custom filters

Custom filters let you customize and define how your action executes. You can do this by either 
uploading a previously defined script file or by writing a new one. 

MarkVision Messenger provides a very simple scripting language to define filters. The following is a 
complete list of the statements and conditions you can use to write a custom filter:

Statements: 

• While (Condition) 

• WaitUntil (Condition) 

• IfThen (Condition) 

• { StatementList } 
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• Distribute 

Conditions:

• And (Condition_1...Condition_n) 

• Or (Condition_1...Condition_n) 

• EventDataIs (key, value) 

• SourceDataIs (key, value) 

• TimeIsAfter 

As an example, let's look at the script representation of the built-in Trigger on Active filter:

IfThen (EventDataIs("state", "ACTIVE"))

Distribute

The effect of the EventDataIs condition is to ask the event for the value of the event.state keyword. 
This is the same keyword you can insert into command lines and e-mail messages. The first 
statement, an IfThen, executes the next statement if the condition EventDataIs ("state", 
"ACTIVE") is true. An EventDataIs condition is true if the value of the keyword (state) matches 
the given value (ACTIVE). The next statement, Distribute, causes the command to execute.

Now, let's look at the script to write when the Trigger on Active filter is set with a delay of 30 seconds:

{ 

WaitUntil (TimeIsAfter(30)) 

IfThen(EventDataIs("state", "ACTIVE")) 

Distribute 

} 

The braces ({}) are used to group statements into a list. They were not needed in the previous 
example because the IfThen and following statements were treated like a single statement.

The WaitUntil statement causes the script to pause execution until the condition is true. The 
TimeIsAfter condition checks for true only after the specified number of seconds has passed. 
Once the 30 seconds has passed, if the event is still Active, the Distribute statement executes the 
command.

The script representation of the built-in Trigger on Either Active or Clear filter is a single Distribute 
statement. Let's say, for example, that you select Paper Tray Missing as the event, but you only want 
to execute the command when the event occurs for Tray 3. Also, you want to wait 20 minutes before 
executing the command, and execute the command again at the same 20-minute interval if the 
condition remains Active. Let's look at the script to write for this filter:

While (And(EventDataIs("state", "ACTIVE"), EventDataIs("location", "Tray 3"))) 

{ 

WaitUntil(TimeIsAfter(1200)) 
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IfThen(EventDataIs("state", "ACTIVE")) 

Distribute 

} 

In this example, And was used to build a compound condition. The While loop is only entered or 
repeated if the event is active for Tray 3. The code within the loop is the same as the code for the 
Trigger on Active filter, except the TimeIsAfter condition is set to wait 1200 seconds (20 minutes).

Trigger on Either Active or Clear filters 

Choose the Trigger on Either Active or Clear filter if you want to set your Action to execute each 
time a condition becomes Active or Cleared. 

For example, let's say you want to keep a log of all printer paper jams so you can determine the 
average time it takes for a jam to be cleared. When a paper jam occurs, the printer generates an 
event with a state of Active. This satisfies the condition of the filter and executes your Action.

When the paper jam is cleared, the printer generates another event with a state of Clear. This event 
also satisfies the condition of the filter and executes your Action. You now have two lines in your log 
file, one with the time at which the paper jam occurred and another with the time it was cleared.

Trigger on Active filters

Choose the Trigger on Active filter if you want to set your Action to execute its command only when 
a condition becomes Active. 

When you pull out a tray, the printer generates a Paper Tray Missing event with a state of Active. This 
satisfies the condition of the filter and executes your Action, perhaps by sending an e-mail 
notification. 

When you push the tray back into place, the printer generates another Paper Tray Missing event, this 
time with a state of Clear, which does not satisfy the condition of the filter. Therefore, your Action is 
not executed and no one is notified when the event is cleared.

You can also choose to delay execution of your Action until the condition has been Active for a 
specified amount of time. Let's say the e-mail recipient is receiving too many notifications and you 
want to wait 20 minutes to see if the condition clears. By using the Delay Time option, you can create 
a filter that won't send the e-mail notification unless the Paper Tray Missing condition has been Active 
for 20 minutes.

Note: The Delay Time value is limited to 10 characters.
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How do I use MarkVision Messenger?

Use MarkVision Messenger to create Actions that automatically perform printer administration tasks 
in response to printer events. 

Use the following examples for ideas about how you can use MarkVision Messenger to:

• Keep a log of all printer paper jams 

• Delay event notifications 

• Monitor specific paper trays 

• E-mail or page someone when a specific event occurs 

• Order supplies 

Step 1: Preview the steps

To create an Action:

1 From the MarkVision Messenger Home screen, click Create New. 

2 Define your Action by completing the following steps in order: 

a Name and describe your Action. 

b Set user access. 

c Select the Event Type that will trigger your action. 

d Select the events or folder that will trigger your Action. 

e Select the devices to monitor for your Action. 

f Select the type of command to execute. 

g Compose the command, and any parameters, for the event(s). 

h Select or create a filter for the events. 

i Verify Action information. 

Note: If you no longer want to preview your choices, select Do not display this screen 
again.

Step 2: Name your Action

The name you choose associates the Action you create with the name that appears in the Action list 
on the MarkVision Messenger Home screen. 
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From the Description Information screen:

1 Enter a unique name for you Action in the Name: field. 

2 Enter a more detailed description about your action and what it does in the Description: field. 

3 Enter instructions associated with your Action in the Notes: field. For example, "Please clear 
the paper jam." 

4 Click  when you're ready to continue. 

Notes:

The Name: field is limited to 80 characters. 

The Description: field is limited to 255 characters. 

The Notes: field is limited to 255 characters. 

Step 3: Set user access

User access determines who can see, use, and change the Action you create. 

From the Access screen:

1 Select Public to make your Action available to all users. 

2 Select Private to make your Action available only to you. 

3 Click  when you're ready to continue.

Notes: 

• This screen only appears if user accounts have been created in MarkVision Professional. 

• A private Action does not require a special access password from within MarkVision 
Messenger. However, since it is associated with the username used to create it, the Action is 
only accessible to that specific user. 

Step 4: Select the Event Type

You must tell MarkVision Messenger which type of event your Action will monitor.

From the Event Type screen, you can:

• Choose to monitor Printer Status Alerts. 

• Choose to monitor Printer Folder Alerts. 

Click  when you're ready to continue.

For more on Event Types, see How does MarkVision Messenger work? 
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Step 5: Select specific events or folder

Depending on the Event Type you have chosen, you must now tell MarkVision Messenger either the 
Device Status Alerts your Action will monitor, or the folder whose events your Action will monitor.

If your Action is triggered by a Printer Folder Alert

1 Select a folder. 

2 Click  when you're ready to continue. 

If your Action is triggered by a Device Status Alert

From the Events screen you can:

• Add an event to the Selected Events: list: 

1 Choose whether to sort events by Type or Severity. 

2 Select an event category. 

3 Add events to the Selected Events: list by: 

– Selecting an event, and then clicking . 
– Selecting [All events], for example [All Input Alerts], and then clicking . 

– Clicking  to add all category events. 

4 Click  when you're ready to continue. 

• Remove an event from the Selected Events: list

Select the event you want to remove, and then: 

– Click  to delete the event from the list.

– Click  to delete all events from the list.

Notes: 

• Selecting [All events] adds all category events to the Selected Events: list, even ones added 
to the server later.

• You can select from one or more event categories, one or more events, or a combination of 
the two.

Step 6: Select devices

You must choose which devices you want to monitor. For your convenience, MarkVision Messenger 
provides you with a list of all available devices capable of producing the events you selected.

From the Event Sources screen, you can:
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• Select All Devices on the MarkVision Server to monitor all devices, even ones added to the 
server later. 

• Select Devices in a Specified Folder to monitor all devices in a specified folder, even ones 
added to the folder later. 

• Select Selected Devices to specify which devices to monitor. 

If you choose Selected Devices, you can:

• Click the name of a specific device in the Selected Devices list to select it. 

• Click Select All to select all devices currently in the Selected Devices list. 

• Click Deselect All to remove all devices selections from the Selected Devices list. 

Click  when you're ready to continue.

Notes: 

• If your Action is triggered by a Folder Event, you may be confused to be asked to choose a 
folder for a second time. By choosing a folder on this screen, you can narrow the list of 
printers you are interested in. In MarkVision Professional, printers can occupy more than one 
folder at a time. 

• For example, if your Action is triggered when printers move into a folder named "Toner Level 
< 10%," and you only want to monitor printers in the folder named "Building 7." select the 
"Building 7" on this screen. MarkVision Messenger will execute your Action when a printer 
from the "Building 7" folder enters the "Toner Level < 10%" folder. 

Step 7: Select a command

You must tell MarkVision Messenger which type of command your Action will execute. 

From the Command Type screen, you can:

• Choose to execute a command line on the MarkVision Server. 

Note: Because command lines are run on the MarkVision Server, you must be logged in 
as the MarkVision administrator to select this option.

• Choose to send an e-mail message. 

• Choose to execute a command line on a remote host. 

Note: This option requires that a rexec server be present on the remote host.

• Choose to setup a Tivoli event adapter.

Note: this option is only available if the Device Status Alert option is selected. 

Click  when you're ready to continue.
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Step 8: Compose the command

Keywords represent information about your Action, a device, or an event. You can pass this 
information to your command on the MarkVision Server or a remote host, or choose to embed it in an 
e-mail message.

To send an e-mail message 

1 Enter the recipient's e-mail address in the To: field. Make sure you separate multiple e-mail 
addresses with a comma. 

2 Enter optional e-mail addresses in the Cc: field. Make sure you separate multiple e-mail 
addresses with a comma. 

3 Enter the purpose of your e-mail in the Subject: field. 

4 Enter your e-mail message in the Body: field. 

5 Add keyword(s) to any text field by: 

• Selecting a keyword from the Keywords: list, and then clicking .
• Typing the keyword directly into the field. 

6 Click  when you're ready to continue. 

Note: If you have not set up your SMTP mail server, you will be prompted to enter your 
mail server and mail path information. 

To execute a command line on a remote host 

1 Enter the remote host information in the Hostname:, Username:, and Password: fields. 

2 Enter the name of an executable command in the Command Path: field. 

3 Add keyword(s) to the Command Line Parameters: field by: 

• Selecting a keyword from the Keywords: list, and then clicking .
• Typing the keyword directly into the field. 

4 Click  when you're ready to continue. 

To execute a command line on the MarkVision Server

1 Enter the name of an executable command in the Command Path: field. 

2 Add keyword(s) to the Command Line Parameters: field by: 

• Selecting a keyword from the Keywords: list, and then clicking .
• Typing the keyword directly into the field. 

3 Click  when you're ready to continue. 
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To setup a Tivoli event server

To execute this command, see Setting up the Tivoli event adapter.

Step 9: Select a filter

A filter lets you control commands that execute when events occur. Your filter options depend on the 
Event Type.

If your Action is triggered by Device Status Alerts:

• Choose Trigger on Active to set the command to execute only when a condition becomes 
Active. You can also choose to delay execution of the command until the condition has been 
active for a specified amount of time. 

• Choose Trigger on Either Active or Clear to set the command to execute each time a 
condition becomes Active or Clear. 

• Choose Custom to customize and define when the command executes. You can do this by 
either uploading an existing script file or writing a new one. 

If your Action is triggered by Printer Folder Alerts:

• Choose Simple Filter to set the Action to execute when a device is added to the folder, 
removed from the folder, or both. You can also choose to delay execution of the command 
until the condition has been active for a specified amount of time. 

• Choose Custom to customize and define when the command executes. You can do this by 
either uploading an existing script file or writing a new one. 

Click  when you're ready to continue.

Step 10: Customize a filter

If you choose Custom from the Filter Type screen, you can customize and define how your action 
executes. Do this by either uploading a previously defined script file or by writing a new one. 

• To upload a previously defined script file: 

1 From the Custom Filters screen, enter the name of the script file you want to upload, or 
click Browse... to locate it. 

2 Click Load. The script file appears in the text field. 

3 Click  when you're ready to continue. 

• To write a new script file: 

1 From the Custom Filters screen, type new script information into the text field. 

2 Click  when you're ready to continue. 
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Notes: 

• Click Tips for more information and sample scripts. 
• When you upload a script file, all information in the text field is erased. Make sure you upload 

the script file first, and then make changes or enter additional information. 

Step 11: Verify Action information

When you're finished, you should verify all Action information for technical accuracy. Carefully review 
the detailed summary provided in the text field. 

When you're ready to continue:

• Click Yes to enable your Action. 

• Click No to disable your Action. 

• Click  to step back through the setup process and make changes. 

• Click  to create your Action and return to the MarkVision Messenger Home screen. 

• Click  to return to the MarkVision Messenger Home screen without creating an Action. 

Note: You cannot alter information directly in the text field. If you want to make changes, 
click  to step back through the setup process and make changes from the 
appropriate screens.

Modifying an Action

1 From the MarkVision Messenger Home screen, find the Action you want to change. 

2 Click Modify. 

You are presented with the same series of choices you used to create an Action, but each choice 
defaults to the current setting for the Action you selected. You may change any or all of your previous 
settings. 

Notes:

• You cannot modify an Action that is enabled by another user. 

• You cannot modify an Action that another user has selected. 
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Enabling an Action

1 From the MarkVision Messenger Home screen, select the Action you want to enable by 
clicking the box to the left of the Action name. 

2 Click Enable Selected. The status of the selected Action changes to Enabled. 

Note: You cannot enable an Action that another user has selected. 

Disabling an Action

1 From the MarkVision Messenger Home screen, select the Action you want to disable by 
clicking the box to the left of the Action name. 

2 Click Disable Selected. The status of the selected Action changes to Disabled. 

Note: You cannot disable an Action that another user has selected. 

Deleting an Action

1 From the MarkVision Messenger Home screen, select the Action you want to delete by 
clicking the box to the left of the Action name. 

2 Click Delete Selected. The selected Action is removed from the Actions list. 

Notes:

• You cannot delete an Action that is enabled by another user. 

• You cannot delete an Action that another user has selected. 

Viewing Action information

To display a detailed summary of an Action:

1 From the MarkVision Messenger Home screen, click the name of the Action. 

2 Click Done when you are ready to return. 

Note: You can only view information for one Action at a time.

You cannot make changes to the Action from the screen. If you want to make changes:

1 From the MarkVision Messenger Home screen, find the Action you want to change. 

2 Click Modify.

See Modifying an Action for more details.
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Setting or changing user data

User data identifies and provides more information about a specific device or set of devices. It is 
associated with the action.sourcedata keyword string that can be inserted into the Command Line 
Parameters: list. You can associate the same data with one or more devices.

To set or change user data:

1 From the MarkVision Messenger Home screen, click Set User Data. A list of all available 
devices and current user data is displayed. 

2 Enter your device information in the Data: field. 

3 Select the devices you want to associate with this data. You can:

• Click the box to the left of a device name to select it.
• Click Select All to select all devices.
• Click Deselect All to remove all device selections. 

4 When you're finished:

• Click Apply to save your changes and refresh the Set User Data screen.
• Click Done to return to the MarkVision Messenger Home screen. 

Notes: 

• User-defined data is user specific and cannot be viewed or altered by another user. 

• The Data: field is limited to 80 characters. 

Generating reports

You can create Actions to generate event-specific reports. 

For example, you're an account administrator and you want to set up an Action to generate a report 
containing billing and delivery information for all supplies that have been ordered.

1 From the MarkVision Messenger Home screen, click Create New. 

2 Enter your Action information in the setup screens that follow, and then click Next. 

3 From the Events screen, select Supplies Alerts from the Categories: list. 

4 Select the events you want to monitor and click the (>) button to add them to the Selected 
Events: list. 

5 Click Next when you are ready to continue. 

6 Select the devices you want to monitor, and then click Next. 

7 Enter your command information and keywords in the appropriate fields. 

8 Click Next, and complete the remaining steps. 
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Keeping a log of paper jams

You can create an Action to keep a log of specific device events.

For example, you may want to keep a log of paper jams to determine the average time it takes for 
them to be cleared.

To set up an Action to log paper jams:

1 From the MarkVision Messenger Home screen, click Create New. 

2 Enter your Action information in the setup screens that follow, and then click . 

3 From the Event Type screen, select Printer Device Status Alerts, and then click . 

4 From the Events screen, choose [Output Alerts] from the Categories: list. 

5 Select Paper Jam as the event, and then click  to add it to the Selected Events: list. 

6 Click  when you're ready to continue. 

7 Select the devices you want to monitor, and then click . 

8 Select Execute a Command Line on the MarkVision Server, and then click . 

Note: Because command lines are run on the MarkVision Server, you must be logged in 
as the MarkVision administrator to select this option.

9 Enter the name of an executable command in the Command Path: field. 

Note: Make sure the command you enter can accept the keywords you insert and write 
them to the end of a log file.

10 Select the keywords you want to appear in the log file, and then click  to add them to the 
Command Line Parameters: field. 

Note: Make sure you insert the keywords in the correct order.

11 Click  when you're ready to continue. 

12 From the Select a filter screen, select Trigger on Either Active or Clear. 

Note: This creates two lines in the log file: one that logs the time at which paper jams 
occur, and another that logs the time they are cleared.

13 Click , and then complete the remaining steps. 

Delaying Event notifications

You can set up an Action to delay execution of its command until an Event has been active for a 
specified amount of time. 
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Let's say you created an Action to send an e-mail notification when a Load Paper or Envelope 
condition occurs. But after a week, the e-mail recipient is receiving too many notifications, and often 
when he goes to a device, someone else has already loaded more paper. By using the Delay Time 
option, you can create a filter that will only send a notification if the Load Paper or Envelope condition 
has been active for an amount of time that you specify.

Likewise, if your Action is triggered by a Folder Alert, you can delay its execution by using the With a 
delay of: option.

If you want to create an Action that uses the Delay Time option:

1 From the MarkVision Messenger Home screen, click Create New. 

2 Enter your Action information in the setup screens that follow, and then click . 

3 Enter the filter information: 

If your Action is triggered by Device Status Alerts

• From the Filter Type screen, choose Trigger on Active. 

• Under Delay Time, specify how long you want the Action to wait to execute its command. For 
example, type in 20 and select Minute(s) from the drop-down list. 

If your Action is triggered by Folder Alerts

From the Filter Type screen, select Simple Filter. 

Under with a delay of:, specify how long you want the Action to wait to execute its command. For 
example, type in 2, and then select Hour(s) from the drop-down list. 

Click OK, and then complete the remaining steps. 

Monitoring specific device paper trays

You can use a filter to narrow the Events that trigger your action.

Let's say you configured Tray 2 on all your devices for your company's letterhead and you only want 
to monitor for Load Paper or Envelope events on Tray 2. For this example, the Trigger on Active or 
the Trigger on Either Active or Clear filter is not sufficient.

To write a custom filter to monitor specific paper trays: 

1 From the MarkVision Messenger Home screen, click Create New. 

2 Enter your Action information in the setup screens that follow, and then click . 

3 From the Event Type screen, choose Printer Device Status Alerts, and then click . 

4 From the Filter Type screen, choose Custom, and then click . 
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5 In the text field, enter a script that only executes the command when the parameter is the 
paper tray you want to monitor. For example: 

IfThen (EventDataIs("location", "Tray2"))

Distribute

6 Click , and then complete the remaining steps. 

Sending an e-mail

You can create an Action to automatically send an e-mail to someone when a specific event occurs.

For example, your network administrator must be notified each time an Operator Intervention Alert 
occurs, but he is rarely at his desk. If your administrator has an alphanumeric pager, you can set up 
the Action to send an e-mail to his pager and promptly alert him when the event occurs.

To create an Action to send an e-mail:

1 From the MarkVision Messenger Home screen, click Create New. 

2 Enter your Action information in the setup screens that follow, and then click . 

3 From the Event Type screen, choose Printer Device Status Alerts, and then click . 

4 From the Command Type screen, choose Send SMTP E-mail.

Note: If you have not set up your SMTP mail server, you are prompted to enter your mail 
server and mail path information. 

5 Enter the recipient's e-mail address in the To: field. Make sure you separate multiple e-mail 
addresses with a comma. 

6 Enter optional e-mail addresses in the Cc: field. Make sure you separate multiple e-mail 
addresses with a comma. 

7 Enter the purpose of your e-mail in the Subject: field. 

8 Enter your e-mail message in the Body: field. 

9 Add the appropriate keyword(s) to any text field. 

10 Click , and then complete the remaining steps. 

Ordering supplies

If you have an automated ordering system on your network, you can set up an Action to 
automatically order supplies for all devices attached to the server.

For example, you can configure an Action to automatically order toner when the first Supply Low 
event occurs. You can also use the Delay Time option to tell your command to ignore Supply Low 
and Supply Empty messages for 10 days after the first event. This lets your Action invoke the 
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automated ordering system to order toner for the printer, and allows time for the new toner to arrive 
and be installed before more Supply Low and Supply Empty messages are logged. 

To create an Action to order supplies:

1 From the MarkVision Messenger Home screen, click Create New. 

2 Enter your Action information in the setup screens that follow, and then click . 

3 From the Event Type screen, choose Printer Device Status Alerts, and then click . 

4 From the Events screen, choose Supplies Alerts from the Categories: list. 

5 Select Supply Low and Supply Empty, and then click  to add them to the Selected 
Events: list. 

6 Click Next when you're ready to continue. 

7 Select the devices you want to monitor, and then click . 

8 Select Execute a Command Line on the MarkVision Server, and then click . 

9 Enter the path to the automated ordering system program in the Command Path: field. 

10 Select the keywords to pass to the automated ordering system, and then click  to add them 
to the Command Line Parameters: field. 

Note: Make sure you insert the keywords in the correct order.

11 Click  when you're ready to continue. 

12 From the Filter Type screen, choose Trigger on Active. 

13 Under the Delay Time option, enter 10, and then select Day(s) from the list box. 

14 Click , and then complete the remaining steps. 

Setting up a SMTP mail server

MarkVision Messenger lets you set up and store your SMTP parameters to use for all your e-mail 
messages. 

To set up a SMTP mail server:

1 From the MarkVision Messenger Home screen, click SMTP Setup. 

2 Enter your mail server information in the SMTP Mail Server: field. 

3 Enter your e-mail information in the From: field. 

4 Click Done to return to the MarkVision Messenger Home screen. 
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Setting up the Tivoli event adapter

The Tivoli event adapter lets administrators monitor printer events accross a range of devices in real 
time. In order to send device status alerts to Tivoli, you must create an action in MarkVision 
Messenger. 

1 Click Create New on the MarkVision Messenger Home screen. 

2 Enter a name for the adapter, and if desired, input a description and any notes. Click . 

3 Select the type of alert that you want to send an event to the Tivoli event server, and then 
click . 

Note: The Tivoli event adapter will be available in a subsequent section of the wizard only 
if the type of events selected on this screen are Device Status Alerts. 

4 Select the type of event that will trigger the action from the Event scroll box, and then use the 
arrow buttons to move the event to the Selected Events box. Click . 

5 Choose the method of device selection. Click . 

6 Select Send Device Status Alerts to a Tivoli Event Server from the dialog box, and then 
click . 

7 Enter your Tivoli configuration settings, and then click . 

8 Determine when the action should execute, and then click . 

A summary of the action that you have created is displayed. If you are satisfied with the action, click 
Yes and then  to enable the Tivoli event adapter. 

Note: After creating a Tivoli event adapter in MarkVision Messenger, you must then 
configure the Tivoli server for Messenger alerts. Refer to your Tivoli documentation 
for details on how to configure your Tivoli server. 
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6 Troubleshooting 

Problems with user accounts and account groups

Error reading account

When you log in, MarkVision validates your account by requiring a user name and password. 

At login, if you see: 

A message that indicates there was an error reading accounts 

Possible causes 

• The user name or password you entered is invalid. See Error reading password. 
• You have logged in to the wrong MarkVision Server. 
• The MarkVision Server is not running. 
• The file containing your account information is corrupt. 

User actions 

Contact your administrator.

Administrator actions 

From the Services control panel, verify that the MarkVision Server is running on the Web 
server. 

If the service is not running: 

1 Stop and restart the service. 

2 Ask the user to attempt to log in again. 

If the service is running:

1 Log in to MarkVision using the default administrator username and password. 

2 Reconfigure or add the user's account (User Accounts task). 

3 Ask the user to attempt to log in again. 
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Error reading password

When you log in, MarkVision validates your account by requiring a user name and password. 

At login, if you see: 

A message that indicates there was an error reading the password.

Possible causes

• The MarkVision Server is not running on the Web server. 
• The file containing your password is corrupt. 
• You have incorrectly typed in your password. Passwords are case sensitive. 

User actions 

Ask your administrator to reset your password.

Administrator actions

From the Service control panel, verify that the MarkVision Server is running on the Web 
server. If it is not running, stop and restart the service. 

If the service is running, reset the user's password:

1 Click User Accounts from the All Tasks menu. 

2 Select the appropriate account, and then click Edit. 

3 Change the password information as necessary. 

4 Ask the user to log in again. 

Forgotten password

When you log in, MarkVision validates your account by requiring a user name and password. 

If you have forgotten your password

User actions

Ask your administrator to reset your password.

Administrator actions

Reset the user's password. 

1 Click User Accounts from the All Tasks menu. 

2 Select the appropriate account. 

3 Change the password information as necessary. 
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Problems with network devices

MarkVision is unable to find a network device

1 Make sure the printer is turned on and is ready. 

2 Make sure the LAN cable is plugged into both the print server and into the LAN, and is 
working properly. 

3 If you are using an INA: 

• Make sure the print server is properly installed and enabled. Print a setup page for the 
printer. See your print server documentation for instructions. The print server should 
appear in the list of attachments on the setup page. 

• Make sure TCP/IP on the print server is activated. The protocol must be active for the 
print server and MarkVision to work. You can do this from the printer operator panel. 

4 If you are using an ENA: 

• Check the print server lights. Refer to your print server documentation for instructions. 
• Print a setup page from the print server. Refer to your print server documentation for 

instructions. 

5 Make sure the SNMP community name you supplied to MarkVision is the same as the one 
set in the print server. 

6 PING the print server. 

• If PING works, check the IP address, netmask, and gateway to make sure they are 
correct. Turn the printer off, and then PING again to check for duplicate IP addresses. 

• If PING does not work, check the setup page you printed to be sure IP is enabled. 
• If TCP/IP is enabled, check the IP address, netmask, and gateway to be sure they are 

correct. 
• Make sure bridges and routers are functioning correctly. 
• Make sure all the physical connections among the print server, the printer, and the 

network are working. 

7 Turn the printer and the print server off, and then on again. Turn the printer on first so when 
you turn on the print server, it can determine whether the printer is enabled for NPA. 

“Device not responding” message appears

1 Make sure the printer is turned on and is ready. 

2 Make sure the LAN cable is plugged into both the print server and into the LAN, and is 
working properly. 



 

Problems with network devices
90

3 If you are using an INA: 

• Make sure the print server is properly installed and enabled. Print a setup page for the 
printer. Refer to your print server documentation for instructions. The print server should 
appear in the list of attachments on the setup page. 

• Make sure TCP/IP is activated on the print server. The protocol must be active for the 
print server and MarkVision to work. You can do this from the printer operator panel. 
Refer to your print server documentation for instructions. 

4 If you are using an ENA: 

• Check the print server lights. Refer to your print server documentation for instructions. 
• Print a setup page from the print server. Refer to your print server documentation for 

instructions. 

5 PING the print server. 

• If PING works, check the IP address, netmask, and gateway to make sure they are 
correct. Turn the printer off, and then PING again to check for duplicate IP addresses. 

• If PING does not work, check the setup page you printed to be sure TCP/IP is enabled. 
• If TCP/IP is enabled, check the IP address, netmask, and gateway to be sure they are 

correct. 
• Make sure bridges and routers are functioning correctly. 
• Make sure all the physical connections among the print server, the printer, and the 

network are working. 

6 Use MarkVision to see if the server can contact the printer. 

7 Compare the IP address of the print server to the address stored for the network printer in the 
name server or /hosts file. If the addresses do not match, edit the /hosts file or update the 
name server to correct the address. 

8 Print a setup page from the print server. If the page prints, the connection between the print 
server and the printer is working correctly. If the page does not print, check all physical 
connections. 

Printer information appears incorrect

Occasionally, the printer may lose contact with MarkVision because something happens to the 
printer. For example, if the printer is turned off, the information in MarkVision is not updated until the 
printer is turned back on. 

If MarkVision displays printer or print server information that appears to be incorrect, refresh the 
printer and print server. 
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No printer icon(s) appear

When you log in to MarkVision and see: 

A message that indicates there was an error reading printers.

Possible causes

• The MarkVision Service is not running on the server. 
• The file that stores your printers has been corrupted. 

User actions 

Contact your administrator.

Administrator actions 

From the Services control panel, verify that the MarkVision Server is running on the Web server. If it 
is not running, stop and restart service. If the service is running, ask the user to repopulate the folder 
with printers. Select the printer, and then click Edit. Use filters or manually select printers.

Printers are missing from folders (no login error messages).

Possible causes

The file that stores your printers has been deleted from the Web server. 

User actions

Repopulate your folder with printers. Select the printer, and then click Edit user filters or manually 
select printers. 

Problems with MarkVision Messenger

Cannot access MarkVision Messenger

Possible causes:

• The URL you entered is incorrect. 

• The MarkVision Web Server service is not running correctly. 

• The MarkVision Web Server is not your default Web server, and you have forgotten to add 
port 9180 in your address. 

User actions:

• Verify that you entered the URL correctly. 

• Contact your administrator. 
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Administrator actions:

• Verify that the user is using the correct URL address. 

• Restart the MarkVision Web Server service to verify that it is running correctly. 

No e-mail notification

Possible causes:

• The e-mail address you entered is incorrect. 

• The MarkVision Web Server service is not running correctly. 

User actions:

• Verify that the e-mail address in the To: field of the Compose SMTP E-mail screen is correct. 

• Verify that the SMTP mail server and mail path are correct. 

• Contact your administrator. 

Administrator actions:

• Review the system log. 

• Verify that the mail server is running. 

• Restart the MarkVision Web Server service to verify that it is running correctly. 

Problems with actions

Cannot create a new action

Possible cause:

The MarkVision Web Server service is not running correctly. 

User action:

Contact your administrator. 

Administrator action:

• Verify that the MarkVision Web Server service is running correctly. 

• Restart the service. 

• Ask the user to log in again and attempt to create an action. 
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Cannot enable an action

Possible cause:

Another user has selected the action. 

User action:

Try again later, or contact the user who has selected the action. 

Cannot disable an action

Possible cause:

Another user has selected the action. 

User action:

Try again later, or contact the user who has selected the action.

Cannot modify an action

Possible causes:

• The action is enabled by another user. 

• Another user has selected the action. 

User action:

Try again later, or contact the user who has selected the action.

Cannot delete an action

Possible causes:

• The action is enabled by another user. 

• Another user has selected the action. 

User action:

Try again later, or contact the user who has selected the action.

Action did not work

Possible causes:

• The command line contains an error. 
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• The wrong device is selected. 

• The wrong event is selected. 

• The selected device is not operating. 

• The MarkVision Web Server service is not running correctly. 

User actions:

• Click the action name to review a detailed summary and verify its accuracy. 

• Contact your administrator. 

Administrator actions:

• Verify that the selected device is operating correctly. 

• Review the system log. 

• Restart the MarkVision Web Server service to verify that it is running correctly. 

Action has unexpected results

Possible causes:

• The command line contains an error. 

• The wrong event is selected. 

• The MarkVision Web Server service is not running correctly. 

User actions:

• Click the action name to review a detailed summary and verify its accuracy. 

• Contact your administrator. 

Administrator action:

• Review the system log. 

• Restart the MarkVision Web Server service to verify that it is running correctly. 

Action list is empty

Possible causes:

• No actions are available. 

• All available actions are listed as private by other users. 

• The MarkVision Web Server service is not running correctly. 
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User action:

Contact your administrator. 

Administrator action:

Restart the MarkVision Web Server service to verify that it is running correctly. 

No private actions listed

Private actions are associated with individual usernames. Therefore, you can only see those 
associated with your username.

Possible causes:

• No private actions are associated with the username you used to log into MarkVision 
Messenger. 

• The MarkVision Web Server service is not running correctly. 

User actions:

• Use a different username to log in and check for that user's private actions. 

• Contact your administrator. 

Administrator action:

Restart the MarkVision Web Server service to verify that it is running correctly. 

Miscellaneous problems

No folder(s)

If MarkVision does not display your folders, and during login you see: 

A message that indicates there was an error reading folders

Possible causes:

• The MarkVision Server is not running on the web server. 

• The file that stores your folders has been corrupted. 

User actions: 

Contact your administrator.
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Administrator actions: 

• From the services control panel, verify that the MarkVision Server is running on the web 
server. If it is not running, stop and restart service. If the service is running, ask the user to 
recreate their folders (Folder Configuration task - Add).

All folders are missing (no login error messages)

Possible causes: 

The file that stores your folders has been corrupted. 

User actions: 

Recreate the folders (Folder Configuration task - Add).

Out of available memory

If the MarkVision Professional web client performs poorly, crashes, or gives you a memory error, you 
may need to change your system Java plug-in settings. The Java plug-in uses 16MB of RAM 
regardless of how much physical or virtual memory is available. You can improve performance by 
increasing the memory available to MarkVision.

User actions

To change the Java plug-in settings:

1 In Windows, access the Java plug-in settings from the Control Panel. 

2 In the Java Runtime Parameters box, type:

-ms16m -mx64m

Note: The entry "-ms16m" reserves 16MB memory when the application starts. The entry 
"-mx64m" reserves a maximum of 64MB available RAM. If your system has more 
memory, you can specify a larger amount.

For additional Java troubleshooting, refer to the MarkVision README file.

Java plug-in(s) unstable 

The Netscape JDK 1.1 patch to Netscape Navigator 4.04 or 4.05 pre-release causes these Netscape 
versions to become unstable even without using the Java Plug-in. For a workaround, check the 
README file, the Netscape developer Web site at http://devedge.netscape.com, or the Java Web 
site at www.java.sun.com. 

http://devedge.netscape.com
http://www.java.sun.com
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7 Frequently Asked Questions

How do I get to the server after installing?

Accessing the MarkVision Professional Server with the MarkVision Application 

In application form, the client is installed locally so it can be launched just like any other program 
installed on the machine. For example, in Windows environments, you can double-click the 
MarkVision Professional icon on the desktop. This version of the client does not use a Web 
browser. 

After starting the application: 

• Enter the hostname or IP address of the machine running the MarkVision Server, and then 
click Connect. You can also click Browse to locate your server. 

• If user accounts are enabled, you are prompted to enter the name of a user account and its 
password. 

• Click Login. 

Accessing the MarkVision Professional Server with the MarkVision Web Client 

Since the MarkVision Web Client is browser based, you need to open your browser and point it to the 
MarkVision URL. If MarkVision Professional is your default Web server, the URL is: 

http://<your server>/markvision

where <your server> is the IP address or hostname of the machine that is running the MarkVision 
Server. 

If MarkVision Professional is not your default Web server, the URL is: 

http://<your server>:9180/markvision

Note that because this URL uses a non-standard port number, in most browsers, you need to type 
the "http://" in the beginning of the URL. 

Note: The "markvision" part of the URL is case-sensitive; it must be entered in all 
lowercase letters. 

The MarkVision Web Client launches a browser window from which MarkVision Professional runs as 
a Java applet. If you have not already enabled your browser to support Sun's Java Runtime 
Environment (JRE), you must do so at this time. In order to run the Web client, you must first enable 
your Web browser to support JRE by installing the Java plug-in. In Windows environments, the 
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plug-in is provided and you are automatically prompted to install it the first time you run the 
MarkVision Web Client. 

How do I discover printers?

Device Discovery task 

The Device Discovery task can be selected from either the All Tasks list or by clicking Actions → 
Device Discovery from the menus. 

1 Select to search by: 

• TCP/IP Address, Subnet or Hostname 
• TCP/IP Address Range 
• IPX Address 

2 Enter the address information. 

3 Click Include to add it to your search list. 

4 Click Full Discovery. 

You can use a "0" (zero) or asterisk (*) as a wildcard character to perform a device discovery based 
on a network subnet. To stop a device discovery once it has started, click Stop Discovery. 

For a more in-depth look at discovering devices, see Adding and removing devices. 

Quick Find task 

The Quick Find task is capable of initially discovering devices and filtering a device search for 
previously discovered devices. 

While searching by TCP/IP address, multiple devices can be discovered using a wildcard variable 
when typing in the criteria for the TCP/IP address. You can use a zero (0) or asterisk (*) as a wildcard 
character when performing a Quick Find based on a network subnet. For example, in order to find all 
the printers on the 122 subnet, the user would type in the address value 138.188.122.0. This would 
find devices with IP addresses of 138.188.122.2, 138.188.122.3, 138.188.122.4, and so on. 

Note: If you enter a TCP/IP address, MarkVision Professional first checks the list of 
devices already discovered. If the address is not in the list, MarkVision Professional 
initiates a device discovery to find it. 

Note: IPX discoveries can only be performed using the Device Discovery task. 
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Is IPX supported?

IPX management support 

IPX management support is only available for a MarkVision Server running on a Windows NT, 
Windows 2000, Windows XP, or Windows 2003 Server workstation. UNIX clients can connect to a 
Windows-based MarkVision Server to manage printers with the IPX protocol. 

IPX protocol support must be installed on the Windows NT, Windows 2000, Windows XP, or Windows 
2003 Server workstation. If IPX protocol support is not installed, the IPX option is disabled. The 
NetWare protocol for the supported print server must be active to be discovered. 

Note: Not all devices are available through IPX support. 

IPX printer installation support 

The easiest way to configure the print server for NetWare jobs in non-NDPS and non-NEPS 
environments is to use the Network Printer Utility for NetWare (Interwin). The Network Printer Utility 
(Interwin) automatically creates all the necessary NetWare objects (print queue objects, print server 
objects, and printer objects). 

Is there any way to speed up device discoveries?

The time MarkVision Professional takes to discover devices varies, depending on the scope of the 
discovery. A device discovery spanning multiple subnets (133.122.0.0) requires more time than a 
device discovery spanning a single subnet (133.122.123.0). 

From the Scheduling task, the MarkVision Server can be set to perform network discoveries once, 
daily, weekly, or monthly. Device discoveries can be scheduled to occur at off times, when network 
traffic is less busy, and routinely scheduled device discoveries ensure that the list of devices 
MarkVision Professional manages is current. 

For a more in depth look at discovering devices, see Adding and removing devices. 

How do I set up Printer Inventory?

You can use the MarkVision Server to gather and store information about the devices in your 
organization. You can then view the collected information (printer inventory) using a database tool or 
an application, such as MarkTrack, specifically designed to interpret and display the information. 

Note: If you are using a MarkTrack database, MarkTrack version 2.0 or later is required. 

Use the information gathered by the printer inventory process to answer questions such as: 

• How many printers do we have on our server(s) / network? 

• What types of printers do we have? 

• What options are installed on our printers? 



 

How do I set up Printer Inventory?
100

• What is the lifetime page count of our printers? 

Enable printer inventory

1 Select Printer Inventory from the All Tasks menu. 

2 Select the database you want to use. 

3 Enter the username, password, and connection path (URL) for the database you plan to use. 

Note: The URL is the path to the database used to monitor this server. MarkVision 
currently supports the following databases: Access, Oracle, and SQL Server, as 
well as CSV format (Comma Separated Variables). 

4 Add the printer(s) from which you would like to collect printer inventory to the Selected 
Printers box. You can select printers from folders or perform a quick find to locate the printers 
you need. (Select multiple printers by using the Ctrl or Shift key.) 

5 Click Apply. 

If you would like printer inventory to run at a specific time, select Scheduling from the All Tasks 
menu. 

The following table shows the path styles used for each type of database.

Database Description

Oracle The default is the path to the MarkVision Server. If the database is installed on a different 
server, change the URL field appropriately, using the path style below: 

<database driver>@<database server's IP address>:<database port>:<database 
instance (memory area)> 

For example: jdbc:oracle:thin:@117.124.46.113:1521:orcl 

Access, 

SQL Server 

<database driver>:<DSN> 

For example: jdbc:odbc:yourdsn 

DSN is a Data Source Name, which must be created prior to using Job Statistics or Printer 
Inventory. Use your ODBC configuration in Windows' Control Panel to create a DSN. 

Note: Exporting this information through an ODBC interface is only supported in a 
Windows environment. 

CSV CSV format provides you the option to export your printer data into a text file formatted to 
accommodate database fields. Enter the directory address where you want the text file to 
be created on your network or computer. 

For example: C:\temp\printerinventory\home
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How do I set up Job Statistics?

Enabling Job Statistics tells MarkVision Professional to collect information about each print job sent 
to a specific printer. This includes information such as job size, job duration, output bins used, and so 
on. 

Enable Job Statistics

1 Select Job Statistics: Trend Analysis from the All Tasks menu. 

2 Select the database you want to use. 

3 Enter the username, password, and connection path (URL) for the database you plan to use. 

4 Select the type of job statistics to use and whether or not status alerts should be 
documented. 

5 Select the property to use to locate the printer. 

6 Add the printer(s) for which you want to enable Job Statistics to the Selected Printers box. 
You can select printers from folders or perform a quick find to find the printers you need. 
Select multiple printers by using the Ctrl or Shift key. 

7 Click Apply. 

Notes:

• To enable Job Statistics, use the Scheduling task. 

• If you are using a MarkTrack database, MarkTrack version 2.0 or later is required. 

• The URL is the path to the database used to monitor this server. MarkVision currently 
supports the following databases: Access, Oracle, and SQL Server, as well as CSV format 
(Comma Separated Variables). The following table shows the path styles used for each type 
of database. 
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What are the differences between the Application and the Web 
Client? 

Differences between the MarkVision Application and the MarkVision Web Client 

The MarkVision Application and Web Client are essentially the same program. All folders, filters, 
devices, and so on that are managed by the MarkVision Server are available to users of either the 
application or the client, provided that the user has been granted access. 

The Web Client requires the installation of the Java browser plug-in. Since the Web Client runs 
through a Web browser, you can use it to access the MarkVision Server from any computer on your 
network. 

What do the lines through some devices mean?

Because the nature of MarkVision Professional is such that all tasks are available all of the time, it is 
possible to choose devices that do not support a given task. For example, not all printers can report 
their toner/ink levels. When this occurs, the name of the device incapable of the selected task has a 
line through it. It looks similar to the following:

dhcp-193.prt.print.printing.com 

If a device that does not support the current task is selected, MarkVision Professional responds in 
the following way: 

• For a single device selection, the message Device Incapable of Task is displayed. 

Database Description

Oracle The default is the path to the MarkVision Server. If the database is installed on a different 
server, change the URL field appropriately, using the path style below: 

<database driver>@<database server's IP address>:<database port>:<database 
instance (memory area)> 

For example: jdbc:oracle:thin:@117.124.46.113:1521:orcl 

Access, 

SQL Server 

<database driver>:<DSN> 

For example: jdbc:odbc:yourdsn 

DSN is a Data Source Name, which must be created prior to using Job Statistics or Printer 
Inventory. Use your ODBC configuration in Windows' Control Panel to create a DSN. 

Note: Exporting this information through an ODBC interface is only supported in a 
Windows environment. 

CSV CSV format provides you the option to export your printer data into a text file formatted to 
accommodate database fields. Enter the directory address where you want the text file to 
be created on your network or computer. 

For example: C:\temp\printerinventory\home
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• When multiple devices are selected, and one or more of them do not support the current task, 
either of the following occurs: 

– For read-only tasks (such as status and toner levels), MarkVision Professional displays 
the Device Incapable of Task message in place of the task information for that 
device. All supported devices have their appropriate information displayed. 

– For multi-device configuration tasks, MarkVision Professional warns you that some of the 
devices will not be affected by the task because they do not support the function or 
feature that is being configured. 

How do I create a filter and apply it to a folder?

Filters provide an easy way to view devices of a certain type or status.

Create a filter

1 From the menu bar, select MarkVision → Filters. The Filter Creation window appears. 

2 Click New. 

3 Give your filter a meaningful name. 

4 Under the Name dialog box, select either Basic or Advanced. 

• If you select Basic 

Select the filter conditions. If you select more than one condition, you can specify whether 
a device must meet any or all conditions in order to be included in the folder. If All is 
selected, a device must meet all conditions. If Any is selected, a device must meet at least 
one condition to be included in the folder. 

• If you select Advanced 

You can create conditions by first selecting a parameter, then selecting a logical 
operation, and then selecting or typing in a value. 

For example, if you wanted to "filter out" all color printers, you would: 

1 From the parameter box, select Color. 

2 From the operation box, select Equal To. 

3 From the value box, select Monochrome. 

Likewise, if you wanted to "filter in" all printers with Job Timeouts greater than or equal to 
90 seconds, you would: 

1 From the parameter box, select Job Timeout. 

2 From the operation box, select Greater Than Or Equal To. 
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3 From the value box, type in 90. 

Note: Some values (such as the 90 seconds in the previous example) must be manually 
typed. 

As in the Basic filter configuration, if All is selected, a device must meet all conditions. If Any is 
selected, a device must meet at least one condition to be included in the folder. If only one condition 
is specified, the Any and All radio buttons will be grayed out. 

For a more in-depth look at filters, see Using filters.

Apply a filter to a folder

1 From the menu bar, click MarkVision → Folders. The folder configuration window appears. 

2 Select the folder you want to configure. If you have already applied a filter to this folder, the 
filter settings appear. 

3 If you want to apply a previously created filter, click Load Filter..., and then choose the filter. 

Note: Manual selection overrides filters. For example, if you apply the filter Color Equal 
To Monochrome, and you have already manually selected various color printers, 
those manually selected printers remain in the folder. 

What is MarkVision Messenger?

MarkVision Messenger is a browser-based tool that helps to automate responses to printer problems 
or events. MarkVision Messenger lets you create Actions to automate many printer administration 
tasks. Using its intuitive wizard-based interface, you can configure Actions to:

• E-mail someone when a specific device condition occurs. 
• Order supplies for a specific device when messages, such as Toner Low, occur. 
• Keep a log of paper jams. 

To use MarkVision Messenger, click Actions → MarkVision Messenger Launch or, from a Web 
browser, enter the URL: 

http://<your server>/messenger

where <your server> is the IP address or hostname of the machine that is running the MarkVision 
Server. 

Note: If MarkVision Professional is not your default Web server, the MarkVision 
Messenger address is: 

http://<your server>:9180/messenger

The "messenger" part of the URL is case-sensitive; it must be entered in all lowercase letters. 
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How do you create actions?

The following steps are an example of how to create an Action in MarkVision Messenger. This 
sample Action sends an e-mail message to a fictional address, (paper@jam.com) whenever a printer 
monitored by the MarkVision Server enters a Paper Jam state. 

1 After logging in to MarkVision Messenger, click Create New.

• Type in the name of the Action (required). 
• Type in a description of the Action (optional). 
• Type in notes about your Action (optional). 

2 Click the Next arrow icon. 

3 Choose whether to make your Action private (the Action is only available to you) or public 
(the Action is available to all users), and then click the Next arrow icon. 

4 Choose the event that will trigger the Action. For this example, select Paper Jam from the 
Events list, and then click the  to add Paper Jam to the Selected Events box. 

5 Click . 

6 Select your method of device selection. You can choose to: 

• Monitor All Devices on the MarkVision Server 
• Monitor Devices in a Specified Folder 
• Monitor Selected Devices 

7 For this example, click Monitor All Devices on the MarkVision Server, and then click the 
Next arrow icon. 

8 Select the type of command your Action will execute. For our example, click Send SMTP 
E-mail, and then click the Next arrow icon. 

9 In the SMTP Mail Server box, enter your SMTP Mail Server (mailserver.mycompany.com, for 
example). In the From: box, enter your e-mail address. Click . 

10 Compose your e-mail message. 

• In the To: box, type the fictional paper@jam.com. 
• If you want to carbon copy (Cc) someone, type the appropriate address in the Cc: box. 
• For this example, type Paper Jam in the Subject: box. 
• In the Body: box, type: There is a paper jam at: source.ipAddress, model: 

source.model, and then click . 

Note: Both source.ipAddress and source.model are Keywords. Select them from the 
Keywords list and move them to the Body: box by clicking . The 
source.ipAddress keyword contains the TCP/IP network address (if applicable) of 
the print server to which the printer is attached. The source.model keyword 
contains the model name of the printer. Many keywords are available in MarkVision 
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Messenger, and a description of each is in the Keyword Detail box, directly under 
the Keywords list. 

11 Select the type of filter for your action: 

• Trigger on Active sends an e-mail whenever a printer enters a Paper Jam state. 
• Trigger on Either Active or Clear sends an e-mail whenever a printer enters or exits a 

Paper Jam state. 
• Custom lets you create your own filter script. 

For this example, click Trigger on Active, and then click the Next arrow icon. 

12 You will now see a summary of your action. Click Yes to enable the Action. 

Results of this example 

If a printer monitored by MarkVision Professional enters a Paper Jam state, an e-mail will be sent to 
the fictional paper@jam.com. The subject will be "Paper Jam," and the body will be similar to: 

There is a paper jam at: 123.123.123.123, model: generic printer. 

In this example, 123.123.123.123 is the TCP/IP network address of the print server to which the 
printer is attached, and generic printer is the model name of the printer. 

Where is the README file?

If MarkVision Professional was installed in the default location, the README text file can be found in:

For Windows users:

• Click Start → Programs → MarkVision Professional → MarkVision Professional 
ReadMe 

For UNIX users:

• /usr/markvision/docs/readme

For both Windows and UNIX users:

• You can link to the README file at: 

http:/<your server>/markvision 

where <your server> is the IP address or hostname of the machine that is running the 
MarkVision Server. 

Note: If MarkVision Professional is not your default Web server, you need to change the 
URL to: 

http://<your server>:9180/markvision

http://www.lexmark.com/publications/pdfs/mvpro_10/readme/en/readme.txt


 

How do I change the MarkVision Web Server port?
107

How do I change the MarkVision Web Server port? 

The port upon which the MarkVision Web Server responds to web requests is also configurable. It 
may become necessary to do this if you want to simplify the Web Client URL to make requests on 
port 80, the standard port for web browsers, eliminating the need to specify 9180 in the MarkVision 
URL. 

For Windows-based machines, the MarkVision Web Server port may be changed by editing the 
server.xml file, located in the following path: 

C:\Program Files\MarkVision Server\www\conf\server.xml

Within the server.xml file, locate the following tag section:

<!-- changed to 9180 for non-default web server -->

<http10connector

port=”9180”

secure=”false”

maxThreads=”100”

maxSpareThreads=”50”

minSpareThreads=”10” />

Copy the section and paste it below the original. Under this heading, change the port= value to 80 
and save the changes. In order for the changes to become operational, you must stop and restart the 
web server service. This will allow the MarkVision Web Server to accept requests from both ports. 

Note: The MarkVision Web Server can only be set to listen to port 80 provided no other 
web server is currently using the port. Do not remove the prior section containing 
9180 as some functions of MarkVision may require this port. 

To change the MarkVision Web Server port for UNIX or Macintosh operating systems, run the 
setup.mvj server script, which is included in your operating system’s install package. 
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